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Chapter 1: Pro Tools Menu (Mac Only)

The Pro Tools Menu commands include links to
Pro Tools Preferences, access to Mac OS X ap-
plication management, and the Quit command.

About Pro Tools or About
Pro Tools HD

The About Pro Tools or About Pro Tools HD com-
mand launches the Pro Tools banner, which in-
cludes the version number of your Pro Tools
software.

Preferences

Pro Tools Preferences are available from both
the Pro Tools Menu and the Setup menu.

Mac Application
Management Commands

(Services, Hide Pro Tools, Hide Others,
Show All)

The Pro Tools menu provides access to the fol-
lowing Mac OS X application management com-
mands: Services, Hide Pro Tools, Hide Others,
and Show All. For more information about these
and other Mac OS X features, refer to the docu-
mentation for your Mac computer.

Quit Pro Tools

The Quit Pro Tools command ends your
Pro Tools session and closes the Pro Tools
application.

Chapter 1: Pro Tools Menu (Mac Only)
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Chapter 2: File Menu

File menu commands are used to create and
maintain Pro Tools sessions.

New Session

The New Session command creates a new

Pro Tools session. You can choose to either cre-
ate a session from a template (Create Session
From Template) or create a blank session (Create
Blank Session).

If you choose to create a new session from a tem-
plate, the available templates appear in the Ses-
sion Template List.

Before the session is created, you must also
name the session and choose its Audio File Type,
Sample Rate, Bit Depth, and 1/O Settings in the
New Session dialog.

New Session

() Create Session from Template...
(#] Create Blank Session...

Session Parameters

Audio File Type: Sample Rate:

| BWF (wav) &) | 44.1 khz
Bit Depth: 1f0 Settings
|16 Bit Last Used

(®)24BiL
132 Bit Float

[~ Interleaved

_Cancel | L0k

New Session dialog

Open Session

The Open command opens a session previously
created with Pro Tools. Only one session can be
open at a time.

Open Recent

The Open Recent command lets you open any of
the 10 most recently opened Pro Tools sessions.
It also provides a Clear command to remove all
sessions from the list.

Close Session

The Close command closes the current session
without quitting Pro Tools. Pro Tools prompts
you to save changes before closing the session.

Save

The Save command saves changes made since
the last time the session was saved. You cannot
undo the Save command.

Save As

The Save As command lets you save a copy of
the current session under a different name, or in
a different location. Because the Save As com-
mand closes the current session and allows you
to keep working on the renamed copy, it is use-
ful for saving successive stages of a session.

Chapter 2: File Menu



Save Copy In

The Save Copy In command lets you save a copy
of the currently selected session under a differ-
ent name or in a different location. Session me-
dia can be included in the copy that you save,
with options to save the media at a different bit
depth, sample rate, fader gain level, or file for-
mat type. Sessions can be saved in a variety of
session formats for compatibility with older sys-
tems. This command is useful for archiving ses-
sions.

Save Session Copy.

Session Format. Latest v
Session Parameters

Fader Gain:

BWF (WAV) 2] Bit Depth:
e
sk 5 O 1681t +6dB

® 24 Bit +12 d8
O 32 Bit Float

Audio File Type:

Sample Rate:

Enforce Mac/PC Compatibility
[ Limit Character Set

English (MacRoman

Items To Copy

/ Audio Files [ Session Plug-In Settings Folder
/ Convert to Specified Format [_] Root Plug-in Settings Folder

[_] Don't Copy Rendered Elastic Audio Files [_] Movie/Video Files

[T Main Playlist Only ("] Preserve Folder Higrarchy

| Selected Tracks Only

(" Cancel ) ( 0K )

Save Session Copy dialog

Unlike the Save As command, Save Copy In does
not close the original session, so subsequent ed-
its are made to the original session. The saved
copy becomes a backup copy, and gives you the
option of returning to the earlier version.

When you Save Copy In with a lower bit rate,
Pro Tools Dither with Noise Shaping will be ap-
plied. The Dither setting used for any conver-
sion is the Digidesign® Dither plug-in with
Noise Shaping enabled.

The Items To Copy section of this dialog pro-
vides several options for copying a session along
with its associated files.

4 Pro Tools Menus Guide

For information on sharing sessions between

different platforms, Pro Tools systems, or
Pro Tools software versions, see the
Pro Tools Reference Guide.

Audio Files

When this option is selected, all audio files are
copied to the new location.s

This setting is automatically selected if you se-
lect a Session Format lower than 10.0.

Convert To Specified Format

When the Convert To Specified Format option is
selected, all copied audio files are converted to
the specified audio file format settings in the
Session Parameters section. When this option is
not selected, any copied audio files retain their
original audio file format settings (including
sample rate and bit depth), and are exactly cop-
ied, bit-by-bit.

Q Copying formats bit-by-bit is much faster
" than converting files.

This option is automatically selected if you do
any of the following:

« Save to a session format lower than 10.0.

« Enable Enforce Mac/PC Compatibility.

Don’t Copy Elastic Audio Rendered Files

When this option is selected, Elastic Audio Ren-
dered files are not copied to the new session’s
Rendered Files folder.

When opening the new session, Pro Tools opens
the session with all available media and any
missing Rendered files are regenerated auto-
matically.



Main Playlist Only

When this option is selected, only the main play-
lists are included with the session copy. Any al-
ternate playlists are not included with the
session copy.

When this option is not selected, all playlists are
included with the session copy.

Selected Tracks Only

When this option is selected, only the selected
tracks in the source session are saved with the
session copy. This option is automatically en-
abled when choosing File > Export > Selected
Tracks As New Session.

When this option is not selected, all tracks in the
source session are saved with the session copy.
This option is automatically disabled when
choosing File > Save Session Copy.

Session Plug-In Settings Folder

When this option is selected, the session’s
Plug-In Settings folder is copied to the new loca-
tion. The references to these plug-in settings in
the session are redirected to the copied settings
files.

Root Plug-In Settings Folder

When this option is selected, the contents of the
root-level Plug-In Settings Folder are copied
into a folder named Place in Root Settings
Folder, indicating that these files will need to be
moved to the root level plug-in settings folder
on the destination system before you can use
them. The references to these settings files in
the session are not redirected to point to the
copied files.

Movie/Video Files

When this option is selected, session video files
(Avid or QuickTime) are copied to the new loca-
tion, and session references are updated to point
to the copied video files.

Preserve Folder Hierarchy

When this option is selected, the relative ar-
rangement of session audio files located across
different drives or folders is maintained. The
main folder for the session copy will include
subfolders for each drive or folder in the origi-
nal session and the destination subfolders will
use the same names as the source drives and
folders.

When this option is not selected, the Save Copy
In command copies all files of the same type, re-
gardless of their location, into a single destina-
tion folder.

Save As Template

The Save As Template command allows you to
save the current session as a Pro Tools Session
Template (a .ptxt file).

Save Session Template

8 Install template in system

Category: | Guitar ':]

Name: Piano @

O Select location for template...

’:‘ Include Media

( Cancel \( oK )

Save Session Template dialog

The Save Session Template provides several op-
tions for saving the session as a template.
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Install Template in System When selected, this
option saves the session as a template in the
folder referenced by the Pro Tools Quick Start
dialog (the Session Templates folder). From the
Category pop-up menu, you can select a category
(or create a new one), or you can open the Ses-
sion Templates folder using the Reveal Session
Templates Folder command. You can also name
the template.

Select Location for Template When selected, the
Save As dialog opens, allowing you to save the
session template in any directory location.

Include Media When selected, audio and video
files are saved along with the template.

Revert to Saved

The Revert to Saved command restores the most
recently saved version of a session, discarding
all changes made since the last time you saved.
Reverting to the last saved version of a session is
like closing the session without saving changes
and reopening it.

Send via DigiDelivery

Aspera DigiDelivery™ is a system for efficient
and reliable transfer of digital media files over
the Internet. Send via DigiDelivery lets you send a
Pro Tools session and all of its related files using
DigiDelivery from within Pro Tools.

Anyone can send and receive files from a
DigiDelivery system, even if they do not own a
DigiDelivery network appliance, as follows:

6 Pro Tools Menus Guide

« To send a delivery, senders must have an Inter-
net connection, an account on a DigiDelivery
network appliance, and the DigiDelivery client
application.

o To receive a delivery, recipients only need an
Internet connection and the DigiDelivery client
application. An account on the network appli-
ance is not needed.

For more information about DigiDelivery,
visit the Aspera website
(http://www.asperasoft.com).

Send to Sibelius

The Send To Sibelius command exports all MIDI
and Instrument tracks to Sibelius® or G7 nota-
tion software as a MIDI file. You can then fur-
ther edit the notation in Sibelius (or G7) and
print the score of your session.

Bounce to Commands

The Bounce to commands let you mix tracks to-
gether into one file.

Bounce to Disk

The Bounce to Disk command allows you to mix
together the outputs of all currently audible
tracks routed to a common output path to create
a new audio file. You can use the Bounce to Disk
command to create a submix or to create a final
mix in any of several audio file formats.



Bounce L&J
Bounce Source: [Bus 1-2 (teren) 1=
File Type: MP3 I=]
Format: [Interleaved I=]
Bit Depth: 16 Bit [Re

Sample Rate:

Conversion Quality:

[C]Enforce Avid Compatibility

Conversion Options:
_) Convert During Bounce
@ Convert After Bounce
Import After Bounce
[ Add To iTunes Library
[] Share with SoundCloud

| Cancel ‘ I Bounce...

Bounce to Disk dialog
Main Bounce Options

The following Bounce options are available
when bouncing to the same or different file type,
format, resolution, or sample rate.

Bounce Source Selects the audio output path to
bounce. Only audio routed to the selected path
will be included in the bounce.

File Type Selects the audio file type. Choices on
all systems are WAV (BWF), AIFF, MP3, Quick-
Time, and MXF. Windows systems also include
Windows Media (Windows). Mac systems also
include SD II.

Certain file types are restricted in regards to for-
mat, resolution, and sample rate.

Format Selects the channel format (number of
channels). Choices are mono (summed), multi-
ple mono, or interleaved.

Bit Depth Selects the bit depth. Choices are
32 Bit Float, 24 Bit, 16 Bit, or 8 Bit resolution.

Sample Rate Selects the sample rate (from 8 kHz
to 192 kHz).

Whenever a Bounce to Disk is configured to a
different file type, file format, resolution, or
sample rate, additional options become
available to convert during or after the
bounce. See “Additional Bounce Options” on
page 8 for more information.

Enforce Avid Compatibility Creates frame-accu-
rate edits, wraps the files as OMFI (unless File
Type is MXF), and limits the sample rate options
to 44.1 kHz or 48 kHz. Dithering without noise
shaping will be applied to files being exported
from 24-bit to 16-bit.

Import After Bounce Automatically imports the
audio after it is bounced and adds it to the Clip
List so that it can be used in the session. The
bounced audio can be imported into a new track
(and the Clip List), or the Clip List only.

A The Import After Bounce option is only
available if the target file type and sample
rate for the bounce are the same as the file
type and sample rate of the current session,
and the target resolution (bit rate) is the
same or lower than the resolution of the ses-
sion. In addition, tracks bounced to a Stereo
Interleaved file cannot be imported after a
bounce.

Add To iTunes Library Lets you bounce your mix
to your iTunes library. When this option is se-
lected, the bounced file is copied to your local
iTunes library. If the Add to iTunes Library op-
tion is enabled when bouncing to disk, the resul-
tant audio file is automatically imported into
iTunes the next time you launch the iTunes ap-
plication. If iTunes is not installed on your com-
puter, this option does not do anything.

Chapter 2: File Menu



Share With SoundCloud Lets you share your mix
using SoundCloud, a social audio sharing site
that lets you feature your tracks or playlists on
social networks (such as Twitter, Facebook, and
Google+). When this option is selected, the
bounced file is automatically uploaded to your
SoundCloud account. If you do not have an ac-
count, you can create one for free.

Additional Bounce Options

The following Bounce options are only available
when bouncing to a different file type, format,
resolution, or sample rate.

Conversion Quality Selects the quality, with
option ranging from Low to Tweak Head, when
bouncing to a new sample rate.

Use Squeezer Optimizes the dynamics of the
bounced audio before conversion to 8-bit
resolution.

Convert During Bounce Automatically per-
forms file type, sample rate, and bit resolution
conversion as the file is being bounced.

Convert After Bounce Automatically performs
file type, sample rate, and bit resolution conver-
sion after the file has been bounced.

A The Convert After Bounce option takes
slightly longer than the Covert During
Bounce option, but may better preserve the
timing and results of automation data in
some cases.

8 Pro Tools Menus Guide

Bounce to QuickTime Movie

This command lets you bounce the main video
track (QuickTime or Avid®video) and a mono or
stereo mixdown of your session to a new Quick-
Time movie. Pro Tools will convert the audio
tracks to the selected sample rate and bit resolu-
tion, then create a new flattened movie with the
bounced audio. As a QuickTime file, the new
movie is supported by all software applications
that support QuickTime video. For detailed in-
formation about bouncing video tracks to a
QuickTime or Avid video, refer to the Pro Tools
Reference Guide.

Import

Pro Tools provides several menu commands to
import files and clips into an open session.

Import Session Data

This command lets you import selected session
data from an existing session into the current
session. Use this option to import entire tracks
from one session into another. Options are pro-
vided for text encoding, timecode mapping,
track offset options, sample rate conversion,
and copying, converting, and referencing audio
and video source files. The Import Session Data
command also lets you import the Tempo Meter
Map, and any Key Signature Maps, Mark-
ers/Memory Locations, and Window Configura-
tions.



Pro Tools lets you select specific session data
(such as automation and routing) to import.
You can also import main playlist options—
either replacing existing options or overlaying
elements onto existing tracks.

Impatt Sexsicn Dats
Saures Properties Time Cede Mazcing Opticna
Nama: enclaat amy Waincaia skacine time code alues 8]
Tym: P Torsts 5,169 Sechaions {6 ) .
Crealed by: Pro Tocks TOMMacOS v3.2 152
St fina: 01:00:00:00

Tima-5oge format: 30 Track Offset Options:

Ausa e depeniay: 34

Aucies sarecln ratile} 44100 Ot lieming oy To
Aurdo fia ree(s): 52 11 000000 | MnSees |
Tt Drcading trglsh achoment ()

Audie Media Dpties Samele Rate Comversian Detiom.

44100

E
H
JiE &

Track s 10 o |

Wl lass Optioas:
{80 impert - Reslace existiny plaplan
e P s i aihhi

) Do Mot Imporn

iz PRE Semings
WEAT Maner Semings

Camel ) (OK)

Import Session Data dialog (Pro Tools session data
shown)

If you are importing AAF or OMF sequences,
different options are provided in the Import
Session Data dialog.

For information on importing AAF and OMF
sequences, see “Importing and Exporting
Session Data” in the Pro Tools Reference
Guide.

Import Audio

This command lets you import audio files into
the current session. Audio files can be imported
into a new track (and the Clip List) or the Clip
List only.

Import MIDI

The Import MIDI command imports all tracks
from a Standard MIDI file into Pro Tools. MIDI
files can be imported into a new track (and the
Clip List) or the Clip List only.

Options are provided for importing the Session
Start or Song Start Marker (if the marker is not
located at the session start), importing tempo
map data contained in the sequence, and remov-
ing existing Instrument or MIDI tracks.

Import Video

This command lets you import Avid Video
(Pro Tools|HD systems with an Avid video pe-
ripheral only) or QuickTime into the main video
track (and the Clip List), a new track (and the
Clip List), or the Clip List only.

The Import Video command can also be used to
extract (import) audio from a Quicktime Movie.

Import Clip Groups

This command lets you import clip groups into
the current session. Clip groups can be imported
into a new track (and the Clip List) or the Clip
List only.

Import Sequence from Avid
Interplay
(Pro Tools HD with Avid Interplay Only)

This command opens the Interplay Access
browser for accessing files on Interplay servers.
For more information, see the Pro Tools Avid In-
terplay Guide.
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Import VENUE Channel Names
as Track Names

This command lets you import VENUE channel
names as track names into the current session.
VENUE system channel names, channel order-
ing, and all I/0 routing is transferred to the
Pro Tools session. This information corre-
sponds to channel names and bussing configura-
tions found in the VENUE system Patchbay.

Output routing mirrors input routing in

Pro Tools one-for-one, so that when playing
back Pro Tools tracks through the VENUE sys-
tem, the Pro Tools tracks appear in the same
channels as the corresponding Stage inputs.

Export

Pro Tools provides several menu commands to
export session tracks or data as files.

Export Selected Tracks as
AAF/OMF

The Export Selected Tracks as AAF/OMF com-
mand exports selected tracks in AAF and OMFI
format. Advanced Authoring Format (AAF) and
Open Media Framework Interchange (OMFI) are
industry standard file formats that facilitate the
transfer of digital media between applications
(such as Pro Tools and Avid Video editing soft-
ware).

Export Selected Tracks as New
Session

This command opens the Save Session Copy di-
alog and lets you export any selected tracks in a
session as a new session.

Sessions created with this command can be
opened with Pro Tools 10 or higher only.
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Export Selected Tracks to
Sequence
(Pro Tools HD with Avid Interplay Only)

This command lets you export tracks back into a
sequence in Interplay. For more information,
see the Pro Tools Avid Interplay Guide.

Export MIDI

This command lets you export your Pro Tools
session or individual MIDI or Instruments
tracks as a standard MIDI file. You can export
the file as a Type 1 (multitrack) or Type 0
(merged) Standard MIDI file. The exported
MIDI file includes meter and tempo informa-
tion, and any key signatures in your Pro Tools
session.

Muted MIDI tracks will not be exported.

This can be useful for storing libraries of your
favorite MIDI sequences or SysEx data (such as
bulk or individual patch dumps for your exter-
nal MIDI devices), or for importing MIDI into
notation applications other than Sibelius or G7.

Export Sibelius

This command exports the score from your ses-
sion as a Sibelius (.sib) file. You can then open
your score in Sibelius as transcribed by

Pro Tools, edit the notation in Sibelius as de-
sired, and print the score and parts from Sibel-
ius.

Export Session Info as Text

This command exports the current session as a
tab-delimited text file that can contain clip and
file names, extended timestamp information,
and information about crossfades.



You can export to any of several different text
file formats (including Microsoft Word and Ex-
cel). (Mac only)

— or —

You can export to text (.txt) file format. (Win-
dows only)

Export Session Text

E] Include File List
E] Include Clip List
E] Include Track EDL's

(] Show Subframes

[ Include User Timestamps
Fade Handling

® Show Crossfades

() Don't Show Crossfades

() Combine Crossfaded Clips

Time Format:

| Mins:Secs 2]
File Format:
[ TextEdit TEXT' ]

Export Session Info as Text dialog (Pro Tools HD
shown on Mac)

Get Info

This command lets you enter and save informa-
tion about the session.

Left-column text fields are topic fields. Text en-
tered there is saved with your Pro Tools Prefer-
ences and will appear in all sessions, allowing
you to preset the field to topics that you com-
monly use.

Right-column text fields are information fields
and are session specific and will be saved with
the session.

Score Setup

Selecting Score Setup opens the Score Setup
window. This window lets you set up the page
layout and staff spacing of your score, viewable
in the Score Editor window. You can also enter
the Title and Composer for the score and select
what elements of the score to display. Changes
to the Score Setup update dynamically in the
Score Editor.

Score Setup

Title

Composer

Track Names
Chord Symbols
|| Chord Diagrams

Title and Composer
Page Numbers
Bar Numbers

Spacing

Between Staves:
Between Systems:
Below Title and Composer:

Below Chord Symbels and Diagrams: 0.00

st iz
Page Margs
i inches (@) Milimeters

Score Setup window

Pro Tools provides several options in the Score
Setup window.

Chapter 2: File Menu
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Information

Title Enter the Title for the score. This appears
at the top of the first page.

Composer Enter the Composer for the score.
This appears in the upper right-hand corner of
the first page.

Display

The Display options determine which score ele-
ments you want displayed in the score. Deselect
the elements you do not want displayed in the
score.

Title and Composer Select to display the Title
and Composer on the score.

Page Numbers Select to display Page Numbers
at the bottom of each page.

Bar Numbers Select to display Bar Numbers at

the beginning of each system above the top staff.

Track Names Select to display Track Names for
each staff at the beginning of the score.

Chord Symbols Select to display chord symbols
in the score.

Chord Diagrams Select to display Chord Dia-
grams to display guitar tablature in the score

Spacing
Between Staves Enter the desired amount of

spacing (in staff spaces) between staves.

Between Systems Enter the desired amount of
spacing (in staff spaces) between systems.

Below Title and Composer Enter the desired
amount of spacing (in staff spaces) between the
Title and Composer and the first staff of the
score.

Pro Tools Menus Guide

Below Chord Symbols and Diagrams Enter the
desired amount of spacing (in Inches or Milli-
meters) between Chord Symbols and Diagrams,
and the top stave of each system.

Layout

Page Size Select the page size (Letter, Legal, Tab-
loid, or A4).

Portrait Select to set the page orientation to Por-
trait.

Landscape Select to set the page orientation to
Landscape.

Staff Size Enter the Staff Size (in Inches or Mil-
limeters).

Page Margins Enter the size (in Inches or Milli-
meters) for the top, bottom, left, and right page
margins.

Inches Select to enter Stave Size, Page, Margins,
and Spacing in inches.

Millimeters Select to enter Stave Size, Page, Mar-
gins, and Spacing in millimeters.

Print Score

The Print Score command lets you print the
score from your Pro Tools session. Pro Tools
provides WYSIWYG (“what you see is what you
get”) printing. Configure the Score Setup as de-
sired and show or hide any MIDI and Instru-
ment tracks as desired. Only those tracks that
are shown in the score will be printed.

Exit
(Windows Only)

The Exit command ends your Pro Tools session
and closes the Pro Tools application.



Chapter 3: Edit Menu

Edit menu commands are used to edit and ma-
nipulate the current selection and affect data in
the timeline or the clipboard.

Undo

The Undo command lets you sequentially undo
up to 32 of your previous actions. Certain com-
mands and actions (such as saving) are not un-
doable. The last command in the undo queue
will appear in the menu (for example, “Undo
Paste”).

If no actions are available to undo, the menu
displays a grayed out Can’t Undo.

Redo

After undoing a command or action, you can
redo it by choosing the Redo command. This isa
good way to compare before and after states of
edits.

If no actions are available to redo, the menu dis-
plays a grayed out Can’t Redo.

Restore Last Selection

If you lose the current Edit (or Timeline) selec-
tion and want to restore it, use the Restore Last
Selection command.

If no actions are available to restore, the menu
displays a grayed out Restore Last Selection.

Cut

This command cuts a selection out of its current
location and stores it in memory so that you can
paste it elsewhere.

Copy

This command copies a selection (leaving the
original intact) and stores it in memory so that
you can paste it elsewhere.

Paste

This command inserts cut or copied data into a
location specified with an Edit tool (such as the
Selector tool).

Clear

This command removes the contents within a
selection in the Edit window.

Chapter 3: Edit Menu
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Cut Special

The Cut Special commands let you cut just auto-
mation data from the current selection (without
associated audio, video, or MIDI notes) and
place it in memory to paste elsewhere. Choices
include:

Cut Clip Gain Cuts clip gain settings, so that you
can apply the clip gain settings from one clip to
any other. Clip gain settings cannot be cut
across clip boundaries.

All Automation Cuts all automation or MIDI
controller data whether it is shown or not.

Pan Automation Cuts only pan automation or
MIDI pan data whether it is shown or not.

Plug-In Automation Cuts only plug-in automa-
tion that is shown.

Copy Special

The Copy Special commands let you copy just
automation data from the current selection
(without associated audio, video, or MIDI
notes) and place a copy of it in memory to paste
elsewhere.

Copy Clip Gain Copies clip gain settings, so that
you can apply the clip gain settings from one
clip to any other. Clip gain settings cannot be
copied across clip boundaries.

All Automation Copies all automation or MIDI
controller data whether it is shown or not.

Pan Automation Copies only pan automation or
MIDI pan data whether it is shown or not.

Plug-In Automation Copies only plug-in automa-
tion that is shown.
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Paste Special

The Paste Special commands offers several op-
tions for pasting audio, MIDI, and automation
data into another clip, in the following ways:

Merge Pastes MIDI controller data from the
clipboard to the selection and merges it with any
current MIDI controller data in the selection.
This can be useful for consolidating MIDI data
from several tracks into a single MIDI track.

Repeat to Fill Selection Pastes multiple itera-
tions of audio, video, or MIDI data from the
Clipboard to fill the selection. If you select an
area that is not an exact multiple of the copied
clip size, the remaining selection area is filled
with a trimmed version of the original selection.
This allows you to easily create drum loops and
other repetitive effects. Before the data is
pasted, Pro Tools prompts you to specify a
crossfade to smooth transitions between clips.

To Current Automation Type Pastes the automa-
tion or MIDI controller data from the clipboard
to the selection as the current type of automa-
tion or continuous MIDI data. This lets you copy
one type of automation data to another, or one
type of continuous MIDI data to another type of
continuous MIDI data.

Clear Special

The Clear Special commands let you clear just
automation data from the current clip. Choices
are:

Clear Clip Gain Clears the clip gain settings for
the current Edit selection. This resets the clip
gain for selection to 0 dB. For clips only par-
tially included in the Edit selection, only the
clip gain settings within the Edit selection are
affected.



All Automation Clears all automation or MIDI
controller data whether it is shown or not.

Pan Automation Clears only pan automation or
MIDI pan data whether it is shown or not.

Plug-In Automation Clears only plug-in automa-
tion that is shown.

Select All

This command selects all audio and MIDI data
in one or more tracks.

» To select all clips in a single track, select a
portion of the track, or click the Selector any-
where in a track and choose Select AllL

+ To select all clips on multiple tracks, Shift-
click a clip on each track with the Selector or
Grabber and choose Select AllL

+ To select all clips on all tracks, Select the “All”
Edit Group in the Groups List, click the Selector
anywhere in a track, and choose Select All.

Selection

The Selection commands are for copying or
playing Edit or Timeline selections.

Change Timeline to Match Edit When the Edit
and Timeline selections are unlinked, this com-
mand copies the current Timeline selection to
the Edit selection.

Change Edit to Match Timeline When the Edit
and Timeline selections are unlinked, this com-
mand copies the current Edit selection to the
Timeline.

Play Edit This command plays an Edit selection.

Play Timeline This command plays a Timeline
selection.

Duplicate

This command copies a selection and places it
immediately after the end of that selection in a
track.

Repeat

This command is similar to Duplicate, but allows
you to specify the number of times the selected
material is duplicated. To use this command, se-
lect the material you want to repeat, choose Re-
peat, then enter the number of repetitions.

Shift

This command moves track material earlier or
later in time by a specified amount. To use this
command, select the material you want to move,
choose Shift, then enter the direction and time
value.

Insert Silence

This command creates clips of silence. Make a
selection on one or more tracks, choose Insert Si-
lence, and precisely that amount of silence will
be inserted. The Insert Silence command also in-
serts video black into a video track.

Snap To

This command provides two options for “butt
splicing” successive elements on a track.

Next Snaps a clip (or Edit selection containing
whole clips) to the beginning of the next clip in
a track.

Previous Snaps a clip (or Edit selection contain-
ing whole clips) to the end of the preceding clip.

Chapter 3: Edit Menu
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Trim Clip

This command provides several options for ed-
iting clip boundaries (including looped clips).

To Selection This command removes data be-
fore and after a clip or MIDI note selection, leav-
ing only the selection. This command lets you
quickly remove all data in a clip (and in some in-
stances the entire track) except for the current
selection.

When trimming clips that include fades or are

adjacent to fade boundaries, the fades from the
source clip are adjusted to the new clip bound-
aries.

Start to Insertion This command lets you trim a
clip or MIDI note by automatically removing the
material between the Edit insertion point and
the start point.

End to Insertion This command lets you trim a
clip or MIDI note by automatically removing the
material between the Edit insertion point and
the end point.

Start to Fill Selection This command lets you au-
tomatically reveal underlying material in the
gaps between the clip start and selection start
points.

End to Fill Selection This command lets you au-
tomatically reveal underlying material in the
gaps between the selection end and clip end
points.

To Fill Selection This command lets you auto-
matically reveal underlying material in the gaps
before and after the selection.
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Separate Clip

These commands separate a clip from adjacent
data in the track where it was created. By sepa-
rating a clip, you will also create by-product
clips from data on either side of the separation.
The Separate Clip commands automatically un-
loops and flattens looped clips before separat-
ing.

Separate Clip includes the following commands:

At Selection This command creates new clip
boundaries at the selection start and end points.

When separating clips that include fades, the
status of the fade depends on the Preserve Fades
when Editing preference.

On Grid This command constrains newly cre-
ated clips to start and end on grid points.

At Transients This command automatically cre-
ates clip boundaries on detected transients
within a selection.

Heal Separation

This command repairs separated clips, provided
that the clips are contiguous and their relative
start and end points haven’t changed since they
were originally separated. You can Heal Separa-
tion between two clips if you have trimmed or
changed the start and end points, but not if you
have moved the clips themselves.

Consolidate

This command consolidates multiple clips into a
single clip. When audio clips are consolidated, a
anew audio file is written that encompasses the
selection range, including any blank space,
fades, or clip gain settings.



Mute/Unmute Clip

This command mutes playback of a selected clip.
Choosing the Unmute command unmutes the
clip. This command does not create automation
data.

Q The clip appears greyed out when muted.

Copy Selection To

In Playlists Track view, these commands copy
the current edit selection and paste it to the Main
Playlist, a New Playlist, or a Duplicate Playlist. at
the same time location.

Copy Selection To Main Playlist Copies and
pastes the selection to the main playlist. Any
material already on the main playlist at the same
location is overwritten.

Copy Selection to New Playlist Creates a new,
empty main playlist and copies and pastes the
selection to the new main playlist

Copy Selection to Duplicate Playlist Duplicates

the current main playlist and copies and pastes
the selection to the duplicate of the main play-
list. The previous main playlist moves to a new
Playlist lane.

Strip Silence

This command opens the Strip Silence window.
Use this window to remove areas of silence from
a selection. Strip Silence automatically divides a
selection into clips, which can be useful for
quantizing audio to musical values or SMPTE lo-
cations.

Strip Silence

Strip Threshold: -48 dB

Min Strip Duration. m 500 msec
Clip Start Pad: (|} 0 msec
Clip End Pad: (|} 0 msec

Strip Silence window

TCE Edit to Timeline
Selection

This command uses the Time Compression/Ex-
pansion plug-in to fit an audio selection to a
Timeline selection. This is only possible when
the Edit and Timeline selections are unlinked.

Chapter 3: Edit Menu
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Automation

(Pro Tools HD and Pro Tools with Complete
Production Toolkit Only)

Copy to Send

This command lets you copy either the current
values or automation of a selected track’s vol-
ume, pan, mute, or LFE automation to the corre-
sponding playlist for the send. This is useful
when you want a track’s send automation to
mirror automation on the track itself.

Copy To Send

Copy: E Current Value

] Automation

From: ™ volume
O Pan
] Mute
O LFE
To: Send A -

...of all selected tracks

0K

|
( Cancel )
) S —

Copy to Send dialog

To copy a track’s current control settings to a
send on that track, select Current Value. To copy
the entire automation playlist for the track to a
send, select Automation.

Thin

This command lets you selectively thin areas in
a track where automation data is too dense and
adversely affecting CPU performance. The
amount of thinning performed is determined by
the amount you have selected in the Automation
page of the Preferences dialog. Avoid over-thin-
ning data or it may no longer accurately reflect
the original automation.
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Thin All

This command lets you thin all automation in a
track. The amount of thinning performed is de-
termined by the amount you have selected in the
Automation page of the Preferences dialog.
Avoid over-thinning data or it may no longer ac-
curately reflect the original automation.

Convert Volume Automation to
Clip Gain

This command converts track-based volume au-
tomation to clip gain settings. Volume automa-
tion is cut from the track volume automation
playlist and pasted to the clip. Once volume au-
tomation has been converted to clip gain, the
clip gain settings stay with the clip when moved,
cut, copied, or pasted.

Convert Clip Gain to Volume
Automation

This command converts clip gain settings to
track-based volume automation. Clip gain set-
tings are cut from the clip and pasted to track-
based volume automation at the same timeline
locations as the clip.

Coalesce Volume Automation to
Clip Gain

This command coalesces track-based volume
automation to clip gain settings. Volume auto-
mation is cut from the track volume automation
playlist and coalesced with the selected clip gain
settings.

After volume automation has been coalesced, it
is set to 0 dB in the selection.



Coalesce Clip Gain to Volume
Automation

This command coalesces clip gain settings to
track-based volume automation. Clip gain set-
tings are cut from the clip and coalesced with
track-based volume automation at the same
timeline locations as the clip.

Write to Current and Write to All
Enabled

(Pro Tools HD and Pro Tools with
Complete Production Toolkit Only)

These commands let you write automation
states for one or more parameters to specific
session locations in a single step. This saves you
the trouble of performing multiple automation
passes for different parameters in real time, or
having to graphically draw automation state
changes on individual automation playlists.

Write to Current Parameters

This command writes the current value only to
the currently displayed automation parameter.

Write to All Enabled Parameters

This command writes the current settings for all
automation parameters enabled in the Automa-
tion Enable window.

Trim to Current and Trim to All
Enabled

(Pro Tools HD and Pro Tools with
Complete Production Toolkit Only)

These commands let you use trim values as
snapshots and apply the relative changes (or
delta values) to the selected automation. This is
similar to the Write Automation command, except

that it writes delta values instead of absolute
values to automation data. You can use trim val-
ues in writing snapshot automation to any au-
tomatable parameter.

Trim to Current Parameter

This command trims the current value only to
the currently displayed automation parameter.

Trim to All Enabled Parameters

This command trims the current settings for all
automation parameters enabled in the Automa-
tion Enable window.

Glide to Current and Glide to All
Enabled

(Pro Tools HD and Pro Tools with
Complete Production Toolkit Only)

These commands let you manually create an au-
tomation transition (or glide) from an existing

automation value to a new one, over a selected

area.

Q Glide Automation can also be used for
" automating the Surround Panner.

Glide to Current Parameter

This command applies Glide Automation only to
the currently displayed automation parameter.

Glide to All Enabled Parameters

This command applies the Glide Automation for
all automation parameters enabled in the Auto-
mation Enable window.
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Fades

These commands let you create (or delete) a
crossfade between two adjacent audio clips, or a
fade-in or fade-out of a single clip. Crossfade
duration, position, and shape are all selectable.
A selection that crosses multiple clips will create
crossfades for each of the clip transitions. If a
selection includes clips that already contain
crossfades, the existing crossfades will be modi-
fied.

Fades

Y
v
Out Shape <<~ Link ->> In Shape
(®) standard () Equal Power (#) standard
() s-Curve () Equal Gain () s-Curve
O N
= &
E Use Dither
¢ Y
[ Cancel ) [ oK )
Fades dialog

Create The Create command produces a cross-
fade between adjacent clips according to param-
eters you specify with the Fades editor.

Delete The Delete command removes a crossfade
between adjacent clips.

Fade to Start The Fade to Start command creates
a fade-in from the current insertion point to a
clip’s start point.

Fade to End The Fade to End command creates a
fade-out from the current insertion point to a
clip’s end point.
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Chapter 4: View Menu

View menu options and commands control the
display of Pro Tools windows, tracks, and track
data. Some View menu options toggle the dis-
play of various Pro Tools windows or data: se-
lecting the option displays the data, and dese-
lecting the option hides the data.

Mix Window
These options selectively display the following
views in the Mix window:
« Mic Preamps
« Instruments
« HEAT (Pro Tools|HD systems only)
o Inserts A-E
o Inserts F-]
« Sends A-E
« Sends F-J
+ Delay Compensation
 Track Color

« Comments

You can also select All of the displays, or None of
them.

Narrow Mix

This option reduces the width of Mix channel
strips on-screen, allowing you to display the
maximum number of tracks on your computer
monitor. In this view, track names, names of
sends, and plug-in names are abbreviated to ac-
commodate the smaller view. To return to nor-
mal view width, deselect this option.

Edit Window Views
These options selectively display the following
views in the Edit window:

o Comments

o Mic Preamps

o Instruments

o Inserts A-E

o Inserts F-J

o Sends A-E

« Sends F-J

« I/0

o Real-Time Properties

o Track Color

You can also select All of the displays, or the Min-
imal number of displays (Track Color only).

Chapter 4: View Menu
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Rulers

These options selectively display various Time-
base and Conductor rulers in the Edit window.
In addition to providing a timing reference for
track material, Timebase rulers are used to de-
fine Edit and Timeline selections.

Besides selecting individual rulers, you can se-
lect All of the rulers, or the Minimal number of
rulers (which is the main timebase ruler only).

Timebase Rulers
Any or all of the following Timebase rulers can
be displayed at the top of the Edit window:

« Bars:Beats

o Minutes:Seconds

« Timecode

o Timecode 2

o Feet+Frames

« Samples
In addition to providing a timing reference for
track material, the Timebase rulers are also used

to define Edit selections for track material, and
Timeline selections for record and play ranges.

Conductor Rulers
Any or all of the following Conductor rulers can
be displayed:

« Markers

« Tempo (and Tempo Editor)

« Meter

+ Key Signature (and Key Signature Staff)

« Chord Symbols

Pro Tools Menus Guide

The Tempo, Meter, Key Signature and Chord
Symbols rulers indicate changes in tempo, me-
ter, key signature, and chords within the ses-
sion. The Markers ruler displays Markers to im-
portant track locations.

The Tempo Editor is an expansion of the Tempo
ruler, opening in the rulers section of the Edit
window.

You can show or hide the Key Signature Staff in
the Key Signature ruler.

Other Displays

These options let you show or hide the Universe
view, the Track List, Clip List, or the MIDI Edi-
tor. A check mark indicates an open display.

Universe The Universe view displays an over-
view of the entire session, representing audio
and MIDI material on all tracks that are not hid-
den (including tracks that are inactive, or that
contain offline clips). The order in which mate-
rial is displayed in the Universe view corre-
sponds to the track order in the Edit window.

In the Universe view, audio, MIDI, and video
clips on tracks are represented by horizontal
lines that are the same colors as the clips on the
tracks. Additionally, each channel in a stereo or
multichannel audio track is represented indi-
vidually.

Track List This option shows or hides the Track
List.

Clip List This option shows or hides the Clip
List.

MIDI Editor This option opens a MIDI Editor
docked within the Edit window. This option ap-
pears grayed out if no MIDI editor window is
available.



Clip

These options selectively display various data in
clips.

Sync Point This option lets you display or hide
sync points in clips. Clips will align to a sync
point regardless of its display status.

Processing State This option lets you display or
hide the Processing State Indicator on Elastic
Audio clips. When selected, any clips on Elastic
Audio-enabled tracks that have been warped or
transposed display the Processing State Indica-
tor icon.

Name This option lets you display or hide clip
names in tracks in the Edit window. Hiding a
display is useful if you are working at a zoom
level where clip names obscure the view of audio
waveforms.

Channel Name This option lets you display or
hide channel names in clips.

Scene and Take This option lets you display or
hide scene and take information in clips.

Rating This option lets you display the ratings
given to clips.

Overlap This option lets you display or hide the
clip overlap “dog-ear” corner that indicates
overlapping clip boundaries.

Clip Gain Line This option lets you edit the clip
gain settings for any given clip using breakpoint
editing, much like with track-based volume au-
tomation.

Clip Gain Info This option lets you show or hide
the Clip Gain icon.

Current Time This option displays the time
stamp of all clips placed in all tracks according
to their current location in the track.

Original Time Stamp This option displays the
Original Time Stamp of all clips in all tracks.
When a clip is created, it is time stamped rela-
tive to the SMPTE start time specified for the
session. This original time stamp is permanently
stored with the clip and cannot be changed. Ifa
clip is ever moved, it can easily be placed at its
original position using the Spot dialog.

User Time Stamp This option displays the User
Time Stamp of all clips in all tracks. When a file
is first recorded, its User Time Stamp is identi-
cal to its original time stamp. You can change
the User Time Stamp using the Time Stamp Se-
lected command in the Clip List. This allows you
to use a custom time stamp for spotting or re-
spotting the clip to a time location different
from its Original Time Stamp.

No Time This option disables the time stamp
display in clips.

Display on All Channels This option displays the
selected Clip display option on all channels of a
multi-channel clip that was imported from a
field recorder.

Chapter 4: View Menu

23



Waveforms

These options define how waveforms are dis-
played and calculated. Waveforms can be dis-
played normally (as positive and negative
shapes around the zero crossing) or rectified.
They can also be calculated as Peak or Power,
whether displayed normally or rectified. Any
waveform can have an Outline.

Peak When selected, the waveform display is
calculated based on the sample-by-sample peak
level. Peak view is traditionally how Pro Tools
calculates the waveform overview and can be
used for normal or rectified views. Peak view
clearly displays any clipping in the waveform

Power When selected, the wave form display is
calculated according to the Root Mean Square
(RMS). Power view can be used for normal or
rectified views. When zoomed in to the sample
level, Pro Tools always displays Peak view, but
Power view is useful for better seeing the char-
acteristics of the audio in the waveform repre-
sentation when zoomed out beyond the sample
level. For mastering applications in particular,
it can be more revealing of the sonic character-
istics of the audio than Peak view.

Rectified When selected, audio waveforms are
displayed so that their positive and negative
waveform excursions (the portions that fall
above and below the center line) are summed to-
gether and viewed as a single positive-value sig-
nal. This view allows more waveform detail to be
seen in either normal or reduced track height
views. It can be particularly useful when editing
volume automation data, since it depicts wave-
form levels as starting at the bottom of the track.
Rectified Waveform view is an option that can
be enabled in Peak or Power views.

24 Pro Tools Menus Guide

Outlines When selected, audio waveforms are
outlined.

Overlapped Crossfades When selected, audio
waveforms are displayed to show the fade in and
fade out waveforms in crossfades.

Automation

(Pro Tools HD and Pro Tools with Complete
Production Toolkit Only)

These options let you display automation data
(in addition to the main automation data dis-
played in certain automation playlists).

Trim Playlist If automation is not set to coalesce
after every automation pass, this command dis-
plays Trim automation data along with the main
Volume or Send level automation data in the
same automation view. This Trim automation
display cannot be directly edited.

Composite Playlist When a track is a VCA slave,
you can display a composite automation playlist
that shows the contribution of the VCA Master
to the Volume or Mute automation data on the
slave track. This composite playlist reflects the
actual position of the Volume fader on the slave
track. The composite playlist display cannot be
directly edited.



Sends A-E

These options display either send assignments
for all sends, or the controls for individual sends
(Sends A-E). Select Assignment to display all
five of these send assignments.

Sends F-J

These options display either send assignments
for all sends, or the controls for individual sends
(Sends F-J). Select Assignment to display all
five of these send assignments.

Track Number

This command assigns each track a number cor-
responding to its position in the Mix and Edit
windows. When tracks are reordered, track
numbers stay in positional sequence.

Transport

These options selectively display Counters, MIDI
Controls, Synchronization, and Expanded con-
trols in the Transport window.

Main Counter

These view options set how the Time Scale is
displayed in the Main Counter.

Bars:Beats This option displays the Time Scale
in Bars and Beats. Use this Time Scale if you are
working with musical material that must align

with bars and beats.

Minutes:Seconds This option displays the Time
Scale in minutes and seconds.

Timecode (Pro Tools HD and Pro Tools with
Complete Production Toolkit Only) This option

displays the Time Scale in SMPTE frames. The
Frame Rate and Session Start time are set from
the Session Setup window. Pro Tools supports
the following frame rates: 24, 25, 29.97 Non-
Drop, 29.97 Drop, 30 Non-Drop, and 30 Drop
frames per second.

Feet+Frames (Pro Tools HD and Pro Tools with
Complete Production Toolkit Only) This option

displays the Time Scale in feet and frames for
referencing audio-for-film projects. The
Feet+Frames time display is based on the 35
millimeter film format.

Samples This option displays the Time Scale in
samples. This format is useful for high-resolu-
tion sample editing.

Chapter 4: View Menu
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Chapter 5: Track Menu

Track menu commands are used to create,
manage, and edit tracks.

New

The New command lets you add one or more new
audio tracks, Auxiliary Inputs, Master Faders,
VCA Masters, MIDI tracks, Instrument tracks,
or Video tracks to a session.

Audio tracks, Auxiliary Inputs, and Master fad-
ers can be mono or stereo, or a greater-than-ste-
reo multichannel format (Pro Tools HD and
Pro Tools with Complete Production Toolkit
only).

MNew Tracks

Creae 0 new  [Mono ) [ s Track W in [seoe W) *

€ Cree )

" Cancel )

New Track dialog

Group

This command opens the Group dialog, which
lets you create, modify, duplicate, delete, and
assign attributes to groups.

Create Group

Name Group 1 ID: [-d &
Type: O Edit VCA: [ hone -
O wix ("] Follow Globals
@ Mix/Edit
[ Tracks | Attributes  Globals |
Available: Currently in Group:
ke bk3
B b4
ht bks
ft bké
htm
ohl
ohr
kis
Vs
bs
pnal
pror
wxtkl
bwx
Audio 1
Audie 2
wx
sx
sop solo r
bkl v

Use Track Selection from Mix/Edit Window:

( Cancel )

ok )

Group dialog
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Duplicate

This command lets you define how many copies
of a track you want to create, and specifies
whether to copy audio or MIDI data, playlists,
automation, and other attributes.

When duplicating multiple tracks, you can also
choose to have the new tracks follow the last se-
lected track (or have each new track follow its
source track).

Duplicating a VCA slave track without duplicat-
ing its group assignments will coalesce any au-

tomation the duplicate track. The coalesced du-
plicate plays back exactly as if it were in the VCA

group.

Split into Mono

This command splits a selected stereo or multi-
channel track into individual mono tracks that
can be edited and manipulated independently.
The Splitinto Mono command cannot be undone.

Make Inactive or Make Active

This command makes selected tracks inactive,
so that they no longer play back or use any DSP
resources or voices. Inactive tracks can be made
active again by choosing the Make Active com-
mand.

28 Pro Tools Menus Guide

Delete

This command removes tracks from a session.
While audio or MIDI clip data will remain in the
Clip List, the track and its arrangement of the
clips on the deleted track (the track’s playlist)
will be lost.

If the track contains playlists that are not as-
signed to any track, you will be prompted to de-
lete or retain them.

Deleting a VCA Master track will coalesce auto-
mation from the VCA Master to all of its slave
tracks.

Write MIDI Real-Time
Properties

This command applies MIDI quantization, du-
ration, delay, velocity, and transposition param-
eters during playback, as set in Real-Time Prop-
erties View (in the Edit window) or in the MIDI
Real-Time Properties dialog.



Set Record Tracks to Input
Only or Set Record Tracks to
Auto Input

(Pro Tools HD and Pro Tools with Complete
Production Toolkit Only)

Set Record Tracks to Input Only

This command changes all record enabled tracks
to monitor audio input only, regardless of any
punch in or out selection.

Set Record Tracks to Auto Input

This command changes all record enabled tracks
to automatically switch from monitoring input
signals to monitoring recorded tracks. When
set, record enabled tracks monitor audio input
when the transport is stopped. When playback is
started for a punch-in, Pro Tools monitors ex-
isting track material up until the punch point.
While punched in, the input signal is monitored.
On punch-out, monitoring switches back to the
existing track material. This is similar to the
auto-switchinglogic found on digital and analog
multitrack tape machines.

Auto Input Monitoring or
Input Only Monitoring

(Pro Tools Only)

Auto Input Monitoring

In this mode, when session playback is stopped,
Pro Tools monitors audio input. When playback
is started for a punch-in, Pro Tools monitors ex-
isting track material up until the punch point.
While punched in, the input signal is moni-
tored. On punch-out, monitoring switches back
to the existing track material. This is similar to
the auto-switching logic found on digital and
analog multitrack tape machines.

Input Only Monitoring

In this mode, when a track is record-enabled,
Pro Tools monitors audio input only,

Scroll To Track

This command lets you scroll directly to any
track by position number. The Edit window
tracks will scroll to bring the selected track to as
close to the top as possible, and the Mix window
tracks will scroll to bring the selected track as
close to the left as possible.

Chapter 5: Track Menu
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Clear All Clip Indicators

This command clears all clip indication from all
meters.

Coalesce VCA Master
Automation

(Pro Tools HD and Pro Tools with Complete
Production Toolkit Only)

This command lets you commit, or coalesce, the
contribution of a selected VCA Master track’s
Volume and Mute automation to the automation
playlists of its slave tracks (or VCA automation
across an Edit selection).

Coalesce Trim Automation

(Pro Tools HD and Pro Tools with Complete
Production Toolkit Only)

This command applies, or coalesces Trim auto-
mation to the main automation playlist by the
following methods: After Every Pass, On Exiting
Trim Mode, or Manually.
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Clear Trim Automation

(Pro Tools HD and Pro Tools with Complete
Production Toolkit Only)

This command lets you clear Trim automation if
it has not been coalesced on a track. When you
clear Trim automation, automation breakpoints
on all Trim playlists are deleted and all Trim
faders are reset to zero.

Create Click Track

This command lets you create one or more click
tracks. Click tracks are Auxiliary Input tracks
with the Click plug-in already inserted.



Chapter 6: Clip Menu

Clip menu commands are used to manage and
edit clips.

Edit Lock/Unlock

This command lets you Edit-lock a clip or group
of clips that you want to protect from being in-
advertently edited. Clips that are Edit-locked
cannot be edited (such as cutting, deleting, sep-
arating, or trimming) or moved to a different
time location. Copied edit-locked clips can be
pasted to any track or time location, but the
copy will also be Edit-locked at the new time lo-
cation.

Time Lock/Unlock

This command lets you lock to a particular loca-
tion in a track (a beat, SMPTE frame, or sample
location), so it cannot be moved accidentally.
Time-locked clips cannot be moved or deleted.
However, they can be edited in ways that do not
delete or move the clip’s sync point to a different
time location (such as separating, trimming,
AudioSuite™ processing, or even moving the clip
to another track). When separating a Time-
locked clip, any new clips will also be locked to
their time locations.

Send to Back

This command sends the selected clip or clips
behind any neighboring overlapping clips. If
multiple overlapping clips are selected,

Pro Tools will apply the command to each clip as
that clip relates to the neighboring clip on the
right.

Bring To Front

This command brings the selected clip or clips
to the front of any neighboring overlapping
clips. If multiple overlapping clips are selected,
Pro Tools will apply the command to each clip as
that clip relates to the neighboring clip on the
right.

Rating

This command lets you rate different clips on a
scale of 1 to 5, where 5 is the highest and 1 is the
lowest. You can also give clips no rating
(“none”). This is the default rating.

Clip rating is useful for identifying which takes
(clips) you like the most when compositing play-
lists. You can display or hide the clip rating in
clips to facilitate track compositing or regular
editing. You can also show or hide Playlist lanes
based on the ratings of clips in the playlist.
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Group

The Group command creates a clip group from
all elements in the current selection. Selections
can include audio, MIDI, or Video clips on one
or more tracks. Multiple clip groups can be se-
lected and included in new clip groups.

Ungroup

The Ungroup command unpacks the currently
selected clip group, revealing all underlying
clips and any nested clip groups. When there are
multiple nested clip groups, the Ungroup com-
mand will ungroup the front-most top-layer clip
group only, preserving any underlying clip
groups.

Q You can also use the Clip > Ungroup com-
mand on looped clips to unloop and main-
tain all loop iterations as individual clips.

Ungroup All

The Ungroup All command removes all layers of
clip groups and nested clip groups in the cur-
rently selected clip in one step.

Q You can also use the Clip > Ungroup All
© command on looped clips to flatten the
looped clips into one clip.
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Regroup

The Regroup command undoes the last Ungroup
command and regroups the individual clips
back to their former clip group state. This lets
you ungroup a grouped clip, edit its underlying
clips, and regroup it to continue working on
higher-level composition and arranging.

Loop

The Loop command lets you loop audio, video,
and MIDI clips.

Unloop

The Unloop command lets you switch looped
clips back to standard (unlooped) clips so that
they can be edited individually.

Capture

This command defines a selection as a new clip
and adds it to the Clip List. From there the new
clip can be dragged into a track. You cannot cap-
ture selections across multiple clips unless the
data is contiguous material from the same file.

Rename

This command lets you rename the selected clip.
When renaming a clip that was auto-created
during editing, the clip becomes a user-defined
clip and is displayed in the Clip List even when
auto-created clips are hidden.



Identify Sync Point and
Remove Sync Point

This command places a Sync Point at the current
cursor location. When you identify a sync point,
a small down arrow appears at the bottom of the
clip, with a vertical, light grey line indicating
the location of the sync point. This Sync Point
can then be used as the reference point—nudge,
spot, move, and so on—instead of the clip start
or end. When you choose this command, the
current SMPTE time is automatically entered as
the SMPTE location for the Sync Point.

To remove a Sync point from a clip, select the
clip with the Grabber and choose Clip > Remove
Sync Point.

Quantize to Grid

This command adjusts the placement of a se-
lected audio or MIDI clip in a track so that its
start point (or Sync Point, if it contains one)
precisely aligns to the nearest Grid boundary.
Grid units are chosen from the Grid pop-up
menu in the Edit window.

Clip Gain

Pro Tools provides separate commands for by-
passing and rendering clip gain.

Bypass Clip Gain

This command lets you toggle the bypass state of
selected clips. When clip gain settings are by-
passed, the clip is played without gain adjust-
ments, but settings are preserved.

Render Clip Gain

This command applies clip gain settings to the
corresponding audio and resets the clip gain to
0 dB.

s

@ You can Right-click the Clip Gain icon for
any individual clip to access relevant clip
gain commands for that clip. The Clip Gain
Icon Right-click menu operates indepen-
dently of the Clip Gain sub-menu that is ac-
cessible when Right-clicking on an Edit se-
lection. For information, see “Editing Clips
and Selections” in the Pro Tools Reference
Guide.

Elastic Properties

This command lets you view the Elastic Audio
properties of any clip on an Elastic Audio-en-
abled track. You can also edit Event markers for
Elastic Audio.
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Conform to Tempo

This command lets you conform clips on Elastic
Audio-enabled tracks (both sample- and tick-
based) to the session tempo. If necessary, the
Conform to Tempo command analyzes the se-
lected clip to determine its tempo and duration
(in bars and beats), and then applies Elastic Au-
dio processing to conform the clip to match the
session tempo.

Remove Warp

This command removes warping applied to a
clip, butleaves underlying Warp markers intact.
This feature will only remove warping created
by Warp markers (that is, warping caused by
quantization or tempo mapping). This can be
useful if you are not satisfied with the results
and want to revert to the pre-warped clip.

Remove Pitch Shift

This command removes pitch shifts applied to
Elastic Audio-enabled clips using the Pitch
Shift option in the Elastic Properties dialog.
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Chapter 7: Event Menu

The Event menu contains commands for editing
audio and MIDI events.

Time Operations

Pro Tools provides several commands for defin-
ing meter and time over a range of time.

Time Operations Window

This command opens the Time Operations win-
dow. This floating window lets you define me-
ter, click, and song start options by choosing
any of the following commands from the pop-up
menu at the top of the window:

o Change Meter
o Insert Time
¢ Cut Time

« Move Song Start

Time Operations

New Meter: ] / [
Starting at bar: apply change: | to selected range 7|
Change: Y barsof 4/4 to [ bars of 44
Realign:
° Meter ruler only
(| Meter, Tempo, Key, and Chord rulers,
all tick-based markers & tracks, and
Al "~ sample-based markers & tracks

click: [

Warning: hidden tracks will not be affected

Time Operations window, Change Meter option

Change Meter

The Change Meter command lets you specify
complex meter changes for Bar|Beat-based ma-
terial. You can enter meter changes at a particu-
lar bar, make a meter change over a selected area
of time, or add meter changes sequentially one
bar at a time.

Insert Time

The Insert Time command lets you insert an
amount of blank time into conductor rulers,
MIDI tracks, and audio tracks.

Cut Time

The Cut Time command lets you cut a specified
amount of time from conductor rulers, MIDI
tracks, and audio tracks.

Move Song Start

The Move Song Start command lets you redefine
the location of the Song Start Marker.

Chapter 7: Event Menu
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Tempo Operations

Pro Tools provides several commands for defin-
ing tempo events over a range of time (or mea-
sures).

Tempo Operations Window

This command opens the Tempo Operations
window. This window lets you define tempo
events over a range of time (or measures) by
choosing any of the following commands from
the pop-up menu at the top of the window:

« Constant
e Linear

o Parabolic
e S-Curve
o Scale

o Stretch

Selection:

Tempa:

[_|Preserve tempo after selection

Tempo Operations window, Constant page

Constant

This command lets you create a constant tempo
over a selected range of time.

Linear

This command lets you create tempos that
change evenly over a selected range of time.
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Parabolic

This command lets you create tempos that accel-
erate or decelerate following a tempo curve,
which changes the tempo more rapidly or less
rapidly over the selection time.

S-Curve

This command lets you create tempos that accel-
erate or decelerate following a tempo curve with
a definable breakpoint that determines mid-
curve times and tempo values.

Scale

This command lets you scale tempos within the
selection by a percentage amount.

Stretch

This command lets you select a group of contig-
uous tempo events and expand or compress
them into a larger or smaller selection area.



Event Operations

Pro Tools provides several commands for
changing event data over a range of time (or
measures).

Event Operations Window

000 EVENT OPERATIONS

© Transpose by
—Q— -uclavas
— @ I semitones
() Transpose

fom N

b EEED
() Transpose all notes to
1 =
() Transpose in key

— - ) scale steps

Event Operations window, Transpose page

The Event Operations window provides com-
mands to transform groups of MIDI notes to af-
fect pitch, timing, and phrasing. The Quantize
and Restore Performance Event Operations can
also be applied to audio clip start points (or sync
points) or Elastic Audio events. The Event Oper-
ations commands include:

¢ Quantize

« Change Velocity

o Change Duration

« Transpose

o Select/Split notes

« Input Quantize

« Step Input

« Restore Performance

« Flatten Performance

Quantize

This command lets you adjust the placement of
selected MIDI or audio events in a track using
Grid or Groove Quantize.

000 EVENT OPERATIONS

What to Quantize
3 Note On [ INote Off
) Preserve note duration

Quantize Grid
Tuplet;
Offset grid by:

) in time D
I ticks

Randomize:

Options
Swing:
Include within:
Exclude within:
Strangth:

Event Operations window, Quantize page

Quantize lets you choose from two different
types of quantization.

o Grid Quantize lets you adjust the placement of
selected MIDI events, Elastic Audio events, or
audio clips in a track so that their start or end
points precisely align to the quantization
value chosen.

« Groove Quantize lets you adjust the placement
of selected MIDI events, Elastic Audio events,
or audio clips in a track so that their timings,
durations, and velocities align to the selected
groove template grid. Pro Tools installs sev-
eral pre-defined groove templates for use on
all Pro Tools systems. DigiGroove templates
can be created using Beat Detective.

Chapter 7: Event Menu
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Change Velocity Change Duration

This command lets you automatically adjust This command lets you adjust the duration for
Note On (attack) and Note Off (release) veloci- selected MIDI notes. It can be used to make mel-
ties for selected MIDI notes. Use it to make odies and phrases more staccato or more legato.

notes louder or softer, or to create a crescendo
or diminuendo.

Event Operations window, Change Duration page

Transpose

Event Operations window, Change Velocity page This command transposes selected MIDI notes
in key up or down by scale steps.

Event Operations window, Transpose page
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Select/Split Notes

The Select/Split Notes command provides tools
to do the following:

Select MIDI notes based on pitch, velocity, du-
ration, and position. These controls can be
used to select a single note or note range for
the entire length of a clip or track.

Split selected note and controller to the clip-
board, to new tracks, or multiple new tracks
based on pitch (one new track is created for

each different pitch in the selection).

The Select/Split Notes window can be used to
quickly extract a melody line from a keyboard
performance. Or, select a drum kit or similar
multi-voice performance track and automati-
cally create multiple new tracks, one for each

Input Quantize

This command lets you quantize MIDI notes as
they are performed and recorded. While this will
improve the strict rhythmic accuracy of a per-
formance, it can also give it a stiff, mechanical
feel. To preserve the original rhythmic nuances
of a performance, experiment with lower
Strength settings, or deselect the Enable input
quantize option.

000 EVENT OPERATIONS

What To Quantize
[ |Enable Input Quantize

@ Note On [ INote Off
3 Preserve note duration

pitch in the selection.

[sNals] EVENT OPERATIONS

Pitch Criteria
() Allnotes

O Notes vovveen (R & (D
O Top - notes of each chord
() Bottom D rotes of each chord

Other Criteria
[vetocity between D « INNEEED
mEfeEiy  of  ooofd i 000)

(") Position btvn (EENEND RN « AN G

Action
© selectnotes

to

Event Operations window, Select/Split Notes page

Quantize Grid

I mr o

& Tuplet: ] i cirme Y
¥ Offset grid by: ) icks

Options

Swing:

Include within:
3 Exclude within:
3 Strength:

Event Operations window, Input Quantize page
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Step Input

This command lets you use a MIDI controller to
enter notes individually, one step at a time. This
gives you precise control over note placement,
duration, and velocity. With MIDI step input
you can also create musical passages that might
be difficult to play accurately, or at a fast tempo.

000 EVENT OPERATIONS

Enable

Step Increment

[ Tuplet:
Note length:

Options
() Use input velocity
© set velncity to: _D— D

[ Enable Numeric Keypad Shortcuts

"~ Gndostep|" NextStep |
| || |

Redo Step .

Event Operations window, Step Input page
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Restore Performance

This command lets you restore the original
MIDI or audio performance regardless of how
many edits you have made or whether or not the
undo queue has been cleared (for example, by
saving the session). Restore Performance can
also be applied to quantized Elastic Audio
Events or quantized audio clips.

For MIDI, one or more of the following note at-
tributes can be restored: Timing (Quantization),
Duration, Velocity, and Pitch. For audio, only
Timing (Quantization) can be restored.

Select the event attributes to restore:
[ Timing (Quantization)
Duration

[ valocity
[CIPitch

Event Operations window, Restore Performance page

Flatten Performance

This command lets you lock the specified cur-
rent note parameters as the “restore to” state,
overriding the original performance. One or
more of the following note attributes can be flat-
tened: Timing (Quantization), Duration, Veloc-
ity, and Pitch. Flatten Performance can be un-
done.

000 EVENT OPERATIONS

Select the note attributes to flatten:
[ Timing (Quantization)
Duration

[ valocity
[CIPitch

Event Operations window, Flatten Performance page



MIDI Track Offsets

This command opens the MIDI Track Offsets
window. This window lets you create timing off-
sets for MIDI tracks to compensate for MIDI-to-
audio latencies in hardware-based or software-
based MIDI synthesizers.

By configuring a MIDI offset, you can make
MIDI tracks play back slightly earlier (by a spe-
cific number of samples), thereby compensating
for any audio monitoringlatencies. MIDI offsets
affect playback only and do not alter how MIDI
data is displayed in the Edit window.

MIDI Real-Time Properties

This command opens the Real-Time Properties
window. This window lets you adjust and apply
MIDI quantization, duration, delay, velocity,

and transposition parameters during playback.

O O O REAL-TIME PROPERTIES

Apply to: track "Inst 1"
[ Quantize |
“Duration )

Delay |

" Valoeity |
| Transpose | | by~

Write to Track

MIDI Real-Time Properties window

Remove Duplicate Notes

The Remove Duplicate Notes command lets you
quickly identify and remove MIDI notes that
were unintentional “double-hits.”

If a note starts within the first 25% of the dura-
tion of a note of the same pitch which is already
sounding (or within an eighth-note, whichever
is shorter), it is considered a duplicate and is
combined with the previous note. If a note starts
later than 25% of the duration, it is considered
to be a new, distinct note, and is shortened so
that it ends at the same tick at which the next
note starts.

Add Key Change

This command opens the Key Change dialog,
which lets you specify the mode (major or mi-
nor), the key (from seven flats to seven sharps),
the range affected (for example, from Bar 1 to
the next key change), and whether existing notes
on pitched MIDI and Instrument tracks are
transposed.
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Beat Detective

This command opens the Beat Detective™ win-
dow. Beat Detective automatically detects the
tempo of a session and conforms an audio track
or selection to that tempo by separating it into
clips and aligning it to the beats. Beat Detective
is ideal for tailoring a performance to a groove.
For detailed information about Beat Detective,
see the Pro Tools Reference Guide.

Ty Conterm ot (A8 ] S T Tow

Renumber Bars

This command lets you renumber the bars in the
session, effectively changing the bar locations
for all clips, meter and tempo events while leav-
ing their position intact. In doing so, however,
the SMPTE and sample locations of the session
data are not changed.

Renumber Bars

Renumber bars so that...

bbar 1  becomes bar 4

(" Cancel ) (" Renumber )

Beat Detective window

Identify Beat

This command lets you establish a tempo/meter
map for audio that was recorded without listen-
ing to a click, or for imported audio with un-
known tempos.

The Identify Beat command analyzes a selection
range (usually with a distinct number of beats or
measures) and calculates its tempo based on the
specified meter. In doing this, Bar|Beat markers
for the calculated tempo are inserted and appear
in the Tempo Ruler at the beginning and end of
the selection. in addition, meter events are in-
serted into the Meter Ruler.

Add Bar | Beat Marker

Location: [ 1| ooo

Time signature: 4
4
(cancel ) ok )

Identify Beat dialog
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Renumber Bars dialog

All MIDI Notes Off

This command sends an All Notes Off MIDI
message to all MIDI devices connected to your
system to silence any stuck notes.



Chapter 8: AudioSuite Menu

The AudioSuite™ menu lets you access all Au-
dioSuite plug-ins currently installed in your sys-
tem’s Plug-Ins folder. These include free Avid
Effects plug-ins installed with Pro Tools.

AudioSuite plug-ins are non-real-time, file-
based processing plug-ins for Pro Tools.

Plug-ins are located in the AudioSuite menu by
category. This menu includes the following
plug-in categories:

« EQ Plug-Ins

« Dynamics Plug-Ins

o Pitch Shift Plug-Ins

+ Reverb Plug-Ins

 Delay Plug-Ins

« Modulation Plug-Ins

« Harmonic Plug-Ins

+ Noise Reduction Plug-Ins

+ Instrument Plug-Ins

+ Other Plug-Ins

For more information on AudioSuite plug-ins,
refer to the Audio Plug-Ins Guide.

Avid Marketplace

The Avid Marketplace option (for plug-ins) lets
you find Pro Tools plug-ins in the online Avid
Store for rent or purchase.

Chapter 8: AudioSuite Menu
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Chapter 9: Options Menu

The Options menu commands let you select sev-
eral editing, recording, monitoring, playback,
and display options.

Destructive Record

Destructive Record mode lets you record over
existing clips and replace the original audio per-
manently. This lets you conserve hard drive
space. However, if you have sufficient drive
space, it is usually best to disable Destructive
Record mode, and use Pro Tools in Nondestruc-
tive Record mode to avoid losing any previously
recorded material.

Loop Record

Loop Record lets you record take after take
while the same section of audio repeats. Thisis a
convenient technique for quickly recording
multiple takes of a part without losing sponta-
neity.

The time range that is looped and re-
corded—which must be at least one second in
length—is defined by selecting a range in the
Ruler or in a track’s playlist, or by specifying
start and end points in the Transport window.

QuickPunch

QuickPunch™lets you instantaneously punch-in
(initiate recording) on a record-enabled audio
track during playback, then punch-out (exit re-
cording) by clicking the Transport’s Record but-
ton. Recording with QuickPunch is nondestruc-
tive.

TrackPunch

(Pro Tools HD and Pro Tools with
Complete Production Toolkit Only)

TrackPunch lets you punch individual tracks in,
punch individual tracks out, and take tracks out
of record enable without interrupting online re-
cording and playback. Recording with Track-
Punch is nondestructive.

DestructivePunch

(Pro Tools HD and Pro Tools with
Complete Production Toolkit Only)

Destructive Punch is a destructive recording
mode that lets you instantaneously punch in
(start recording) and punch out (stop recording)
on individual audio tracks during playback,
while preserving a contiguous audio file on each
punched track. No additional clips are created
when recording in DestructivePunch mode.
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Prepare DPE
(DestructivePunch-Enabled)
Tracks

(Pro Tools HD and Pro Tools with
Complete Production Toolkit Only)

This command prepares a track for Destructive
Punch recording by consolidating all Destruc-
tive-Punch-enabled tracks from the beginning
of the session to the value specified in the De-
structive Punch File Length preference.

Transport Online

This command arms the Pro Tools Transport for
online synchronization. Playback or recording
can then be triggered by an external timecode
source. Online recording or playback begins as
soon as Pro Tools receives and locks to timecode
or ADAT sync.

Video Track Online

This command enables and disables playback of
the main video track. You may want to give
higher priority to screen updates for other

Pro Tools tasks (such as metering, moving fad-
ers). With QuickTime movies, you may want to
disable a video track to freeze the video at a par-
ticular point in time relative to Pro Tools play-
back.
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Video Out FireWire
(QuickTime Movies Only)

This command plays the current QuickTime
movie out the FireWire port. You may want to
do this to have a Digital Video deck, monitor, or
camcorder record or display DV (digital video)
playback from Pro Tools.

For a list or supported DV FireWire
transcoders, visit our website
(www.avid.com).

Scrub in Video Window

This command opens a Scrub window, which
displays the Avid video at quarter-resolution,
but accurately scrubs the video. When the Scrub
window is open, video output alternates auto-
matically between the Scrub window and the
video reference monitor depending on whether
or not you are scrubbing.

When scrubbing, the video reference monitor is
black. When leaving Scrub mode, the Scrub win-
dow disappears and video is routed to the video
reference monitor.

A The Scrub window is only available in
Pro Tools systems with a qualified Avid
DNA™ video peripheral (such as AVop-
tion|V10 or Mojo®), and when there is Avid
video or QuickTime video in the main video
window.

Pre/Post-Roll

This option enables pre- and post-roll playback.
Pre- and post-roll amounts can be entered in the
Transport window, set from a track’s playlist or
Timebase Ruler, or by recalling a Memory Loca-
tion.



Loop Playback

This option continuously loops playback of a se-
lection until you stop playback. Looping play-
back is a useful way to check the rhythmic con-
tinuity of a selection when working with musical
material. Selections must be at least 0.5 seconds
in length to use Loop Playback.

Dynamic Transport

This mode lets you decouple the playback start
location from the Timeline selection. This
means that you can start playback from any-
where on the Timeline without losing your
Timeline or Edit selections. For example, you
can use Dynamic Transport mode in conjunc-
tion with Loop Playback mode to quickly audi-
tion loop transitions.

Edit Window Scrolling

Pro Tools provides several options for defining
how the contents of the Edit window scroll dur-
ing playback and recording.

No Scrolling

The No Scrolling option disables scrolling during
and after playback. With this option enabled,
the playback cursor moves across the Edit win-
dow, indicating the playback location, up to the
right edge of the Edit window. When the play
point moves beyond the right edge of the Edit
window, the Playback Cursor Locator icons ap-
pear at the right edge of the Main Timebase
Ruler.

After Playback

The After Playback option causes the Edit win-
dow to scroll to the final playback location after
playback has stopped. With this option enabled,
the playback cursor moves across the Edit win-
dow, indicating the playback location.

Page

The Page option causes the Edit window to
scroll during playback. With this option en-
abled, the playback cursor moves across the Edit
window, indicating the playback location. When
the right edge of the Edit window is reached, its
entire contents are scrolled, and the playback
cursor continues moving from the left edge of
the window.

Continuous

(Pro Tools HD and Pro Tools with
Complete Production Toolkit Only)

The Continuous option causes the Edit window’s
contents to scroll continuously past the play-
back cursor, which remains in the center of the
window. With this option enabled, playback is
always based on the Timeline selection (Play-
head).

Center Playhead
(Pro Tools HD Only)

This option causes the Edit window’s contents
to scroll continuously past the Playhead, which
is a blue line in the center of the window (red
when recording).

A\ Regardless of which Scrolling option is
selected in the Options menu, Pro Tools
does not scroll when zoomed down to the
sample level.
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Link Timeline and Edit
Selection

This option lets you link or unlink any Timeline
selection with any Edit selection.

When Link Timeline and Edit Selection is enabled,
making a selection in a track’s playlist (an Edit
selection) also defines the play and record range
(the Timeline selection).

When Link Timeline and Edit Selection is dis-
abled, you can make a selection within a track
for editing purposes that is distinct from the se-
lection in the Timeline (which determines the
playback and recording range).

Link Track and Edit Selection

This option lets you link or unlink any track se-
lection with any Edit selection.

When Link Track and Edit Selection is enabled,
you can make an Edit selection within a track or
across multiple tracks and each associated track
is selected.

When Link Track and Timeline Selection is dis-
abled, making an Edit selection does not auto-
matically select all associated tracks.

Mirror MIDI Editing

This option lets you edit MIDI clips and have
your edits automatically applied to every MIDI
clip of the same name. This can be particularly
useful when editing looped MIDI clips.
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Automation Follows Edit

When this option is disabled, automation events
are not affected by edits to audio or MIDI notes.
When enabled, automation events are affected
by edits to audio or MIDI notes.

Click

When the Click command is enabled, a metro-
nome event is generated during playback and re-
cording. The metronome can trigger an external
MIDI device (as specified by the Output setting
in the Click/Countoff Options dialog) or the
DigiRack Click DSP (AAX and TDM) or Native
(AAX and RTAS) plug-in (see the Audio Plug-Ins
Guide).

MIDI Thru

Enabling the MIDI Thru command routes MIDI
from your controllers to the devices and chan-
nels assigned to the MIDI track currently re-
cord-enabled. This lets you monitor MIDI tracks
while recording.

Mute Frees Assigned Voice
(Pro Tools HD Only)
When this option is enabled, a muted track’s

voice will be allocated to the next highest prior-
ity track assigned to the same explicit voice.



Auto-Spot Clips

When enabled, this option simplifies the task of
spotting clips. If you are using VITC with this
option enabled, or MachineControl™ software,
you can pause your video at an appropriate
SMPTE frame location, click on a clip with the
Grabber, and the clip will be automatically spot-
ted to the current timecode location.

Pre-Fader Metering

This option toggles track metering between pre-
and post-fader operation. When set to Pre-Fader
Metering, level meters show levels independent
of fader position. With post-fader metering, the
level meters respond to fader position. This op-
tion only affects on-screen meters.

Solo Mode

Pro Tools provides several modes and options
for defining how track Solo buttons work.

Solo Modes
(Pro Tools HD Only)

Pro Tools provides several modes for defining
how track Solo buttons work.

SIP (Solo In Place) When this mode is enabled,
the Solo button mutes other tracks so that the
chosen track can be auditioned alone.

AFL (After Fader Listen) When this mode is en-
abled, the Solo button routes the track’s post-
fader/post-pan signal to the AFL/PFL Path out-
put, which is set in I/O Setup.

A\ AFL Solo mode requires the Surround Mixer
plug-in (see the Pro Tools Reference Guide
for installation information).

PFL (Pre Fader Listen) When this mode is en-
abled, the Solo button routes the track’s pre-
fader/pre-pan signal to the AFL/PFL Path out-
put, which is set in I/O Setup.

A\ PFL Solo mode requires the Surround Mixer
plug-in (see the Pro Tools Reference Guide
for installation information).

Solo Latch Options

Pro Tools provides several latch options for de-
fining how track Solo buttons work.

Latch When selected, pressing subsequent Solo
buttons adds them to the soloed mix of tracks.

X-OR (Cancels Previous Solo) When selected,
pressing subsequent Solo buttons cancels previ-
ous solos.

Momentary (Pro Tools HD Only) When selected,
Solo buttons are not sticky. A track is soloed
only when its Solo switch is held down.

Edit/Tool Mode Keyboard
Lock

Enable this option to lock the ability to change
tool types (for example, to change from the nor-
mal Trimmer to the Scrub Trimmer) using key-
board shortcuts. Tool types can still be changed
using the mouse, and you can also still switch
between tools (such as switching from the Grab-
ber to the Trimmer) using keyboard shortcuts.
This option affects the following Edit and Tool
modes: Grid, Zoom, Trim, Grabber, and Pencil.
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Calibration Mode
(Pro Tools HD Only)

Use Calibration Mode in Pro Tools to adjust the
input and output levels for your audio interface
(such as HD I/0 or 192 I/0™) so they match
those of your mixing console and other audio
devices in your studio.

Delay Compensation

When this option is enabled, Pro Tools captures
reported plug-in delays and signal routing for
all tracks and calculates the correct delay for
each track, compensating all the tracks accord-

ingly.
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Activate HEAT

(Pro Tools|HD Systems with the HEAT
Software Option Only)

This command lets you apply HEAT to all active
audio tracks in your session, emulating the ef-
fect of an analog mixing console. Use HEAT to
open up your mixes with warm, analog-modeled
soft-saturated distortion.

For more information about HEAT, see the
HEAT Software Option Guide.

Low Latency Monitoring

(Pro Tools|HD Native, 003 Family, Digi 002,
Digi 002 Rack, and Mbox 2 Pro Only)

This option lets you use the Low Latency Monitor-
ing option to record with an extremely small
amount of monitoring latency, to as many tracks
as each system supports.



Chapter 10: Setup Menu

This menu provides commands to open dialogs
and windows for configuring various Pro Tools
hardware and software parameters.

Hardware

This command displays the Hardware Setup di-
alog, where you can specify settings for your
hardware and sessions. Configure the settings
for any audio interface connected to your

Pro Tools system by selecting it from the Pe-
ripherals list.

The Main page of the Hardware Setup dialog can
be used to define what physical ports are routed
to Pro Tools input and output channels. The
Main page also provides controls for Session
Sample Rate and Clock settings.

Ootical Dutpes Foemat
@ Azt T
Oyswos ) Dt 5708

Opical 07097 /PONF Dutpat Format
‘Sample Ratx Comvarsion Taacam
Rt Ciock Dutpt: | Word Do (44,3 ke 18]

ety Sex T Dttt

[ )

Hardware Setup dialog, Main page (HD OMNI shown)

With Pro Tools HD, additional pages can be
used to configure other parameters on each au-
dio interface (such as setting operating levels).

Playback Engine

This Playback Engine lets you set a hardware
buffer size, define processor allocation on
multi-processor computers, allocate a percent-
age of CPU resources for Pro Tools tasks, and
configure Native (AAX and RTAS) error report-
ing.

On Pro Tools|HD systems, you can select the
number of voices and voiceable tracks for your
system and its sessions. Voice count choices are
based on how much DSP processing you want to
allocate for voicing. If you change the Number
Of Voices setting (Pro Tools HD only) mid-ses-
sion, the session will be saved, closed, and re-
opened to enable the new settings.

| HD TDM &3]
Settings.

H/W Buffer Size: | 256 Samples

Host Processors: | & Processors,

CPU Usage Limit: | g5 % +)

Host Engine: (¥ Ignore Errors During Playback/Record
(may cause clicks and pops)

Number of Voices: | 64 Voices (2 DSPs) =

Sample Rate: | 48 kHz

Delay C Engine: | Long sl

[| Minimize system memory allocation
(takes effect at next restart}

Disk Playback
Cache Size: | Normal 2l

Lower values for the disk buffer reduce memory usage. Higher values imprave disk
performance.

Plug-In Streaming Buffer

Size:

@ Optimize for streaming content en audio drives (reguires more system memory)

ook |

Playback Engine for Pro Tools|HD system

Chapter 10: Setup Menu

51



Disk Allocation

If you are using multiple hard drives for record-
ing, use the Disk Allocation dialog to assign each
track in a session to a specific drive. Audio for
that track will then be recorded to the chosen
drive.

Dk Allocston

Track oot Meda Folder
dmad Castar il dtacad Drmass Dame Saancal, 8 -

{l R Guiw X i\Fibrwd Drua Dwersy Semsicri,

Bass Guar di\Fisered Craam Cema Session,
Auda 1 &1 Tools Samond daced Cesam Daona Sassos)
Comd Bass. i\Fibrwd Druas Dersy Semsicri,
Crem Edn di\Fisered Craam Cema Session,
e dildeaed Draass e Saaneni,
Puriasir i\Fibwrwd Druas Dersy Semsicri,
Vinas di\Fisered Craam Cema Session,

Blada Pad i\ioacad Cnma Dt Saancni,

Custom Allocation Opbons
#oot meda folder:

Use rewnd robin allocation for new trades

[ cemest | [0k ]

Disk Allocation dialog

Peripherals

The Peripherals dialog provides several tabbed
pages (Synchronization, Machine Control, MIDI
Controller, Ethernet Controller, Microphone
Preamp, Satellites, VENUE) for configuring var-
ious peripheral device for use with Pro Tools
(such as SYNC HD™, Command|8®, or PRE™).

Synchronization

This page configures synchronization devices
(such as SYNC HD) to synchronize Pro Tools to
SMPTE Timecode or MIDI Timecode (MTC).

Pro Tools Menus Guide

Machine Control

This page configures MIDI Machine Control
(MMC) and 9-pin machine control devices for
use with Pro Tools. Slaving Pro Tools to MIDI
Machine Control is supported on all Pro Tools
systems. 9-pin Machine Control (Deck Control)
and 9-Pin Remote (Deck Emulation) modes re-
quire the MachineControl™ software option.

MIDI Controllers

This page configures MIDI control surfaces such
as Command|8.

Ethernet Controllers

This page configures D-Control, D-Command,
C|24, or EUCON™ for use with Pro Tools.

Mic Preamps

This page configures one or more PREs for use
with Pro Tools.

Satellite (Pro Tools HD Only)

This page configures Pro Tools for the Video
Satellite, Video Satellite LE, and Satellite Link
options, which allow synchronization between
Pro Tools and Avid video editing systems.

VENUE

This page configures Pro Tools for use with a
VENUE system.
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This I/0 Setup dialog provides tools to label and
map Pro Tools input, output, insert, bus signal,
and Mic Preamp (PRE) paths. The I/0O Setup di-
alog also lets you configure delay compensation
for hardware inserts.

[ rr - il .
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1/0 Setup dialog, Output page

In addition, the I/O Setup dialog, like the Main
page of Hardware Setup, provides controls for
routing the physical ports on your audio inter-
face (such as HD 1/0) to Pro Tools Input and
Output channels. The Output page of the

I/0 Setup dialog also lets you change the default
path settings for Meter, Audition, and multi-
channel track layout (as displayed on-screen).

Machine Track Arming
Profiles

(Pro Tools HD with MachineControl Option
Only)

This dialog provides extensive control over
Pro Tools Track Arming. You can customize
arming, track naming and mapping, and save
configurations for different machines as Track
Arming Profile files. These Profiles can be im-
ported to quickly reconfigure Track Arming as
needed for future projects. You can also test
track mapping, and remap tracks if needed.

Video Sync Offset

The Video Sync Offset dialog lets you offset
video earlier or later in a session so you can ac-
curately spot audio to it.

Avid Video Offset When playing Avid video
through an Avid video peripheral, Pro Tools au-
tomatically compensates for the delay intro-
duced by the peripheral. This means you can
leave the setting at 0 frames and the output of
the Avid video peripheral will be in sync with
the audio. If you have a plasma monitor (which
may introduce an additional delay of two
frames), you can compensate for it by entering
the amount of the delay here.

QuickTime Video Offset Pro Tools does not auto-
matically compensate for the delay when play-
ing QuickTime video through any FireWire pe-
ripheral, including Avid video peripherals. The
amount of delay introduced varies based on
your system and the type of video peripheral you
are using. When using an Avid peripheral with
QuickTime, 18 quarter-frames is a good starting
point, but you will need to verify the precise set-
ting for your system. (Third-party devices are
available to help you measure this delay.)
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Session

The Session Setup window lets you configure
various timecode-related settings on your sys-
tem, as well as certain session format settings
(such as bit depth, pan depth, audio format, and
interleaved).

The window also includes display-only areas for
session sample rate, system delay, and time-
code-related data (such as incoming time).

LIRS At Format |LJBWE QWAMELT) Session Stat
e et Lqepe. T merieaved:
CockSowca  Wemsl T

System Dty =

Pan Depth E. LT B
EYNCISETan & Timecoae CrTse Ty
Sl S

Session Setup window

Current Feet+Frames

Position
Redefine Current Feet+Frames Position ﬂ
Current Timecode Position: 00:00:00:00
Desired Feet+Frames Position: -+

[ Cancel ] [ OK ]

Current Feet+Frames dialog

This dialog lets you specify a Feet+Frames value

based on the current Edit cursor timecode loca-

tion. Typically, this feature lets test tones, pre-
roll, Academy leader, and similar pre-program
material to be more easily integrated into

Pro Tools sessions.
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Current Timecode Position

This dialog lets you redefine the session start
time. By creating an insertion point (or selec-
tion) and then entering the new timecode posi-
tion for that location, the session start time will
be recalculated based on the new, relative
timecode location.

Redefine Current Timecode Position u
Current Timecode Position: 00:00:00:00
Desired Timecode Position: 00:00:00:00]

[ Cancel ] [ OK ]

Current Timecode Position dialog



External Timecode Offset

This dialog lets you compensate for devices that
are consistently offset by a fixed number of
frames (such as some color-corrected video
masters), or for material that starts at a differ-
ent time than the session.

Redefine External Timecode Offsat @
Current Timecode Position: 00:00:00:00
Desired Timecode Pasition: 00:00:00:00]
[ Cancel ] [ OK ]

Redefine External Timecode Offset dialog

Pro Tools provides three different types of Ex-
ternal Timecode Offset settings. These offsets
include:

« MMC (MIDI Machine Control)
e 9-Pin (Serial machine control)
« Synchronization peripherals (such as the

SYNC I/0, or a MIDI interface that provide
MIDI Timecode).

Positive and negative offset values can be en-
tered to offset Pro Tools timecode display later
or earlier, respectively.

Unique values can be defined for each of these
three types offsets, or you can link all three to
adjust in unison.

MIDI

This dialog lets you set up your MIDI environ-
ment.

MIDI Studio

The MIDI Studio dialog launches the Apple Au-
dio MIDI Setup application (Mac) or opens the
MIDI Studio Setup window (Windows). These
let you identify the MIDI devices connected to
your MIDI interface.

MIDI Beat Clock

This dialog lets you enable synchronization for
certain MIDI devices (such as drum machines,
software synthesizers, and hardware sequenc-
ers) to MIDI Beat Clock. Devices selected in the
MIDI Beat Clock dialog will receive the MIDI
Beat Clock signal. If your MIDI interface does
not support transmitting MIDI Beat Clock to
separate ports, the interface will appear as the
only destination.

MIDI Beat Clock

@ Enable MIDI Beat Clock for... Offset (samples)

] Commands, Port 1
] Command8, Port 2
[ Commands, Port 3
[_] Eleven Rack, External
| Eleven Rack, Rig

[ MIDIIJO 1, Port 1
] MIDI l/O 1, Port 2
) MIDIJO 1, Port 3
] MIDI 1JO 1, Port 4
] MIDIlJO 1, Port 5
] MIDIJO 1, Port &
] MIDI I/O 1, Port 7
] MIDIJO 1, Port 8
_J MIDIJO 1, Port 9
) MIDI )0 1, Port 10

[

10

10

100

10

ololalelelelee[eleelae]=]e

Plug-Ins that self-configure to receive MIDI Beat Clock
will not be listed in this dialog.

P

MIDI Beat Clock dialog
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Input Filter

This dialog provides settings for filtering out se-
lected MIDI messages from your recording. The
Input Filter can be set to record all messages,
only the specified messages, or all except the
specified messages. When using the Only op-
tion, only the MIDI messages that are selected
will be recorded. Conversely, when using the All
Except option, the selected messages will not be
recorded.

MIDI Input Filter
Record
O an
O only...
@ All Except...
Channel Info Controllers
0 Notes O [modwheely 78]
U picch Bend O (breatncnri@ 75
¥ Mono Aftertouch [ | foot cntrl (4) ]
™ Polyphonic Aftertouch =) L@
[] Program Changes O @
O (pomamento6s) 7]

] System Exclusive

[ Cancel ) @

MIDI Input Filter dialog
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Input Devices

This dialog enables selected MIDI controllers
and control surfaces so that MIDI data received
from them can be recorded. Disabling devices in
this dialog will ensure that unwanted notes
(such as those from drum machines or an arpeg-
giator) are not recorded.

MIDI Input Enable

™ kzs00

™ miDI 1O, Port 3
™ MIDI 1O, Port 4
™ miDI 1O, Port 5
™ MIDI 1O, Port 6
™ miDI 1O, Port 7
™ MiDI 1O, Port &
™ miDI 1O, Port 9
# MIDI 110, Port 10
™ PRE

(" Cancel ) ( oK )

MIDI Input Enable dialog



Connect to SoundCloud

This dialog lets you log into your SoundCloud
account from Pro Tools.

When logged into SoundCloud, you can use the
Share With SoundCloud option in the Bounce to
Disk dialog to upload bounced files directly to
your SoundCloud account.

Click/Countoff

This dialog lets you configure metronome pa-
rameters such as MIDI note, velocity, duration,
and output. If you are using the Click plug-in,
set the output to None.

Click/Countoff Options

Click

@ During play and record
:_, Only during record

() Only during countoff

Note Velocity Duration
Accented c3 127 100 ms
Unaccented c3 100 100 ms
Output | none _C}
Countoff
E Only during record 2 Bars

Cancel

Click/Countoff Options dialog

Preferences

This dialog determines how Pro Tools features
work. The Preferences dialog has several pages
in which you can specify settings for various ses-
sion parameters.

Q Pro Tools preferences are either global
"~ (apply to all sessions opened on the
system) or local (apply to the current
session only). For more information,
see the Pro Tools Reference Guide.

Display Preferences Determine how windows,
menus, tracks, meters, and color coding appear
on-screen.

Operation Preferences Determine the behavior
of the transport, numeric keypad modes, record
modes, input monitoring, video playback, and
session backup.

Editing Preferences Determine behavior when
selecting and creating clips, creating fades, us-
ing Memory Locations, and zooming.

Mixing Preferences Determine the behavior of
inserts, sends, pan controls, automation, and
control surface banking.

Processing Preferences Determine behavior
when importing audio, using AudioSuite plug-
ins, and using Elastic Audio.

MIDI Preferences Determine behavior when dis-
playing, editing and playing back MIDI data

Synchronization Preferences Determine how a
connected transport (using the MachineControl
or Satellite Link option) responds to Pro Tools.
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Chapter 11: Window Menu

The Window menu provides commands to tog-
gle the display of various Pro Tools windows:
selecting the command displays the window;
selecting the command again hides the window.

Q For Window menu items, keyboard short-
" cuts with number keys only work using the
numeric keypad on your computer.

Configurations

The Configurations menu provides commands
and options to manage the configuration of win-
dows in your session, as well as the internal win-
dow configurations of the Edit, Mix, Transport,
MIDI Editor, and Score Editor windows.

Window Configuration List

This command displays the Window Configura-
tion List, which lets you recall and manage
stored Window Configurations, as well as create
new Window Configurations.

New Configuration

This command displays the New Configuration
dialog, which lets you create a new Window
Configuration.

Update Active Configuration

This command updates the selected Window
Configuration with any changes to the layout
and settings of windows depending on the Win-
dow Configuration’s properties.

Auto-Update Active Configuration

This command automatically updates the active
Window Configuration as you make changes to
the layout and settings of windows.

Arrange

The Arrange commands tile or cascade all open
windows. Floating windows (such as plug-in,
output, and send windows) and the Transport
window are not affected by these commands.

Tile Arranges all open windows in a tiled pattern
on the screen.

Tile Horizontal Arranges all open windows in a
horizontally-tiled pattern on the screen. This
option is not available if there are too many win-
dows open.

Tile Vertical Arranges all open windows in a ver-
tically-tiled pattern, side by side, on the screen.
This option is not available if there are too many
windows open.

Cascade Arranges all open windows in a cascad-
ing pattern on the screen.

Hiding All Floating Windows

The Hide All Floating Windows command hides
or shows all floating windows. This command is
useful for clearing the screen quickly so that you
can work in the Edit or Mix windows.
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Close Window

This command closes the front-most Pro Tools
window.

Mix
This command displays the Mix window, used
for recording and mixing tasks.

Edit

This command displays the Edit window, used
for graphical editing and arranging of audio,
MIDI and automation.

MIDI Editor

This command displays a MIDI Editor window,
which is used to display and edit MIDI data for
one or more MIDI or Instrument tracks. A check
mark indicates that the MIDI Editor is the fore-
most window in the display. A diamond indi-
cates that the MIDI Editor is not in front. You
can have multiple MIDI Editor windows open.

Score Editor

This command displays a Score Editor window,
which is used to view, edit, arrange, and print
MIDI from your session as music notation. A
check mark indicates that the Score Editor is
foremost window in the display. A diamond in-
dicates that the Score Editor is not in front.You
can have multiple Score Editor windows open
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MIDI Event List

This command opens the MIDI Event List win-
dow. This floating window shows the contents of
a MIDI track in a single list, so you can quickly
insert, edit, or locate any type of MIDI data us-
ing your computer keyboard. A check mark indi-
cates that the MIDI Event List is the foremost
window in the display. A diamond indicates that
the MIDI Event List is not in front.

MIDI Editors

These commands lets you choose which Midi
Editor or Score Editor window is foremost on
the screen.

Bring to Front This command brings the MIDI
Editor or Score Editor window to the front.

Send to Back This command sends the MIDI Ed-
itor or Score Editor window to the back, behind
the Edit window.

Midi Editor Window List Thislist shows any open
MIDI Editor or Score Editor windows. Selecting
a window from the list brings the window to the
front.

Task Manager

This command displays the Task Window, used
to monitor, pause, or cancel ongoing tasks.

Workspace

This command displays the Workspace browser,
which can be used for searching, sorting, audi-
tioning, and importing data. The Project, Vol-
ume, and Catalog browsers can be accessed from
the Workspace browser.



Project

This command displays the Project Browser,
used for Pro Tools file management with the
current session.

For more information on the Task window,
Workspace, Project, and other browsers, see
the DigiBase and DigiBase Pro Guide.

Browsers

Use the Browsers command to select a currently
open browser and bring it to the front. The
Browsers submenu can also be used to bring all
currently open browsers to the front, or send all
browsers to the back. Choices include Bring to
Front, and Send to Back.

Transport

This command opens the Transport window.
This window can display counters, MIDI con-
trols, and basic or expanded transport controls
(configure the Transport window from View >
Transport).

[pnn

o e R G

Transport window

Big Counter

This command opens the Big Counter window.
This window provides a large, easy to see refer-
ence for the current session time location. Time
is displayed in the currently chosen Main Time
Scale format.

2:03.000

Big Counter window

Automation

This command opens the Automation window.
This window lets you enable or suspend the
writing of volume, pan, mute, plug-in, send
level, send pan, and send mute automation for
all tracks.

SUSPEND
Write Enable
PLUG IN
VoL sVoL
PAN 5 PAN
MUTE | SMUTE
Manual Write
1 N
e mn
Write on Stop
[ || o] ||
ndm
AUTO JOIN
Auto Match
PREVIEW

capture T

Automation window (Pro Tools HD shown)

Before you can record automation, an automa-
tion type must be enabled. Buttons are high-
lighted when enabled. To suspend writing of au-
tomation, deselect the button for the
automation type.
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Memory Locations

This command opens the Memory Locations
window. Here you can store up to 200 time loca-
tion markers, selections, zoom settings, pre-
and post-roll times, track show and hide states,
track height states, and group enables. To recall
amemory location, click the button for the loca-
tion or, on your computer's numeric keypad,
type a period (.), then the number of the mem-
ory location, then type a period (.) again.

O O O Memory Locations

ol

Memory Locations window

Machine Track Arming

(Pro Tools HD with MachineControl Option
Only)

This command opens the Machine Track Arm-
ing window on systems that have the Machine-
Control option installed. When using Machine-
Control, this window lets you record-arm
external recording devices from within

Pro Tools.
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Video Universe

(Pro Tools HD, and Pro Tools with
Compete Production Toolkit Only)

This command opens the Video Universe win-
dow. The Video Universe lets you view, navi-
gate, zoom, and select video clips on the main
video track.

The Video Universe window displays the center
video frame of each video clip in the main video
track. Video frames are ordered sequentially ac-
cording to their order in the Timeline, and the
colored strip under each frame represents the
color coding for that clip.

Video

This command opens the Video window, which
displays QuickTime movies imported into the
current session using the File > Import > Video
command. This window also displays Avid
Video when it is being scrubbed.

The window provides a sample-accurate, ran-
dom-access reference for spotting sound effects,
music, Foley, dialog, or other audio to the video.

Color Palette

This command opens the Color Palette window.
Use this window to make color selections for
tracks, clips, groups and markers.

Color Palette window



Undo History

This command opens the Undo History window.
Use this window to view a list of undoable and
redoable operations and return to any previous
state. The Undo History can show editing times,
enabling you to revert to the state a session held
at a particular time.

Disk Space

This command opens the Disk Space window.
This window shows the recording capacity of
each hard drive attached to your system, mea-
sured in track minutes. This calculation is based
on the bit depth and sample rate of the current
session.

DISK USAGE

Disk Name  Size  Avail

44.1 kHz 24 Bit Track Mi

Disk Space window

System Usage

This command opens the System Usage window.
This window provide meters that indicate how
much of your system’s processing power is being
used in processing audio, and when writing and
playing back automation.

All versions of Pro Tools have three common
system Activity meters. Avid HDX,
Pro Tools|HD and HD Native systems also
provide a meter for monitoring PCI activity:
« PCI (Avid HDX, Pro Tools|HD, and HD
Native Systems Only)
« CPU (Native)
« CPU (Clip)
« Disk

Pro Tools HD and Pro Tools with Complete
Production Toolkit have two system Cache
meters:

« Disk Cache

o Timeline Cached

With Avid HDX and Pro Tools|HD systems,
there are three additional system usage meters
below the Activity meter:

« Voices Allocated
« Time Slots Used

« DSP Usage (Avid HDX, Accel Core, HD
Core™, HD Accel, and HD Process™ cards)

PCl I 13%

CPU (Native) (I 2%
CPU (Clip) IS 0%
O ——

Disk Cache Iy 100%
Timeline Cached (. 4%

[ /DSF

Voices Allocated [T NG 16/ 06
Time Slots Used (I 15/ 512

=——— DSP Cache
pop-up menu

HD Engine

System Usage window (Pro Tools|HD 2 Accel shown)

With Pro Tools|HD systems, there is also the
DSP Cache pop-up menu, which lets you choose
Use DSP Cache (facilitating quicker session
loading times) or Purge Cache (giving you a
more accurate display of current DSP usage).
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Eleven Rack

(Eleven Rack Only)

This command displays the Eleven Rack window, where you can control Eleven Rack entirely from
your computer. It can be accessed when using Eleven Rack as an interface with Pro Tools, as well as

when connected to Pro Tools HD systems using other audio interfaces (such as HD I/0, 003, or Core-
Audio or ASIO interfaces) for control over USB. The Eleven Rack window is only available when an

Eleven Rack is connected to your Pro Tools system.

AO.A Eleven Rack
VOLUME
MUTE

TUNER USER OPTIONS

RIG INPUT Guitar PHONES MAIN

RIG SETTINGS TRUE-Z VOLUME TEMPO EXP. PEDAL

a1l Bolder Axe |saveT|| Ao T|[d]-142 2| |@] 120.0 2] | Wah 7
]
E

HI-GAIN NORM

Eleven Rack window
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Chapter 12: Marketplace Menu

The Marketplace menu provides commands to
access your Avid account and the online Avid

Store (to shop for plug-ins, Avid support, or up-

grades).

Your Account

This command lets you access and log in to your
online Avid account.

Plug-Ins

This command lets you access the Avid Store to
find plug-ins.

Avid Support

This command lets you access the Avid Store for
support and training options.

Upgrades

This command lets you access the Avid Store for
software options and upgrades.

Chapter 12: Marketplace Menu

65



66 Pro Tools Menus Guide



Chapter 13: Help Menu

The Help menu commands provide links to
Pro Tools Help, important Pro Tools documen-
tation, and online resources.

Pro Tools Help

Select this command to access web-based
Pro Tools Help within the Pro Tools web
browser.

Pro Tools Help provides quick and easy access
to workflows and reference information while
Pro Tools is open. Built-in search capabilities
and an index are included to better support your
Help needs.

When you are connected to the Internet, Help
provides access to the latest Pro Tools Help files
as they become available (independently of ma-
jor Pro Tools releases). If you are not connected
to the Internet, Pro Tools will open the local
English Help files that are installed with

Pro Tools.

When you are connected to the Internet, you
will also have access to translated versions of
Pro Tools Help as they become available. If your
localized language is not available, Pro Tools
Help defaults to the English version.

Pro Tools Knowledge Base

Select this command to visit the Avid website for
the online Avid Knowledge Base using the

Pro Tools in-application web browser. The Avid
Knowledge Base is your best resource for

Pro Tools support and troubleshooting.

Avid Audio Forums

Select this command to access the online Avid
Audio Forums using the Pro Tools in-applica-
tion web browser.

Pro Tools Guides

Select the title of the document you want from
the Pro Tools menu to open the document in
Adobe Reader (available from www.adobe.com).
Available documentation includes:

« Audio Plug-Ins Guide
« Pro Tools Menus Guide
+ Pro Tools Reference Guide

e Pro Tools Shortcuts

Purchase Avid Support and
Training

Select this command to access the online Avid
Store for support and training options.

Chapter 13: Help Menu
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Check For Updates

Select this command to check for Pro Tools ap-
plication and plug-in updates, either automati-
cally or manually. An internet connection is re-
quired to be able to check for updates.

If updates are available for Pro Tools or any
plug-ins, you are notified about what is avail-
able and how important the updates are for your
system. You can then visit the Avid website to
locate, download, and install the appropriate
updates for your Pro Tools system.

About Pro Tools
(Windows Only)

Select this command to display the Pro Tools
banner, which includes the version number of
your Pro Tools software.

68 Pro Tools Menus Guide



Chapter 14: Clip List

The Edit Window displays all audio clips, MIDI
clips, video clips, and clip groups in a single,
comprehensive Clip List.

The pop-up menu at the top of the Clip List pro-
vides general menu commands and tools for
managing the contents of the list.

Find... Ctrl+Shift+F

Select Parent in Project Browser

Select
Sort b'_',"
Ctrl+5Shift+B
Ctrl+5hi
Auto Rename...
Ctrl+Shift+ M

Time Stamp...

Ctrl+Shift+Y
Ctrl+Shift+ K

Recalculate Waveform Overviews

Timeline Drop Order

Clip List pop-up menu

Find

Use the Find command to display all clips in a
list whose names contain a particular word or
phrase. The Find command opens the Find Clips
dialog, which lets you filter searches by name or
to include only those clips added to the session
since the previous search.

Clear Find

This command returns the Clip List to display-
ing clips as they were displayed before the last
Find.

Select Parent in Project
Browser

When this command is enabled, the DigiBase
Project browser automatically highlights the
parent file of any file or clip selected in the Clip
List.

This setting is latching (meaning it maintains its
setting).

Chapter 14: Clip List
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Show Options

These options in the Clip List can show different
types of clips and clip information. Select the
Show options for the items you want to show.
You can also deselect Show options to hide a
type of clip or clip information to streamline the
list of clip names.

Clip Types

Audio Shows Audio clips in the Clip List.
MIDI Shows MIDI clips in the Clip List.
Video Shows video clips in the Clip List.
Groups Shows clip groups in the Clip List.

Auto-Created Shows automatically-created
clips. These are clips that were created as a by-
product of cutting, pasting, and separating
other clips. Since these by-product clips can be-
come numerous, hiding them (by deselecting
the option) helps you to avoid scrolling through
an unnecessarily long Clip List.

Clip Information

Color Shows Track Color Coding as assigned
with Default Clip Color Coding option in Dis-
play Preferences page, or as assigned in the
Color Palette.

File Type Shows whether clips are audio, MIDI
or video files.

Timebase Shows whether clips are tick-based or
sample-based.

Processing State The icon indicates that a clip is
an Elastic Audio clip.

File Name Shows the audio file from which the
clip originated.

Disk Name Shows the name of the hard drive on
which the clip resides.
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Full Path Shows the full directory path name of
the clip’s location.

Channel Name Shows channel names of each
multichannel clip.

Scene and Take Shows the scene and take infor-
mation of each multichannel clip.

Select Options

These options in the Clip List let you select spe-
cific clips so they can be dragged to tracks, pro-
cessed with AudioSuite plug-ins, or exported.

All Selects all clips in the Clip List.

Unused Selects clips that have not been placed
in a track in the current session. Offline clips ap-
pear in the Clip List as italicized and dimmed.

Unused Except Whole Files Selects clips that
have not been placed in a track in the current
session, but do not include whole-file clips.
Whole-file clips are clips that were created when
recording or importing audio, consolidating ex-
isting clips, and when nondestructively process-
ing with an AudioSuite plug-in. Whole-file au-
dio clips reference an entire audio file that
resides on your hard drive. Whole-file audio
clips are displayed in bold in the Clip List

Offline Selects clips whose parent files cannot be
located, or are not available, when opening a
session or importing a track. Offline clips ap-
pear in the Clip List as italicized and dimmed;
they appear in playlists as light blue clips with
italicized names.



Sort By Options

The Sort By options provide methods for orga-
nizing large numbers of clips.

Audio clips can be sorted by:
« Clip Type
« Name
« Length
+ Original Time Stamp
o User Time Stamp
« Timebase
« Startin Parent
« End in Parent
« File Name
+ File Length
« File Creation Date
« File Modification Date
+ Disk Name (audio and clip groups only)
o Track Format/Width
« By Channel Name
+ By Scene and Take

MIDI clips can be sorted by:
« Name, Length
« Original Time Stamp
+ User Time Stamp
o Timebase
« Start in Parent

« End in Parent.

Clips can also be sorted by Clip Type (Audio and
MIDI), or in Ascending or Descending order.

Clear

This command lets you remove unwanted clips
from the session. Whole-file clips can also be re-
moved permanently from your hard drive.

A Clearing whole-file clips is destructive and
cannot be undone. It permanently removes
the file from your hard drive. There is no way
to recover files deleted with this command.

Rename

This command lets you rename selected clips.
When you rename a whole-file audio clip, you
can specify whether to rename just the clip, or
both the clip and the disk file.

Auto Rename

This command lets you specify the auto-naming
options for a clip when new clips are created
from it in the course of editing. You can also use
it to rename a large number of clips at once in
numerical order.

Auto-naming of clips does not affect the names
of parent audio files. Instead, it stores pointers
to the clips within the parent source file.

The Auto Rename command opens a dialog with
the following fields:

Name Determines the root name for the auto-
created clips.

Number Sets the start number for the sequen-
tially numbered new clips.

Zeros Determines the number of zeros that oc-
cur before the auto numbers.

Suffix Specifies text to be appended to the end of
the name, following the auto numbering.
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Time Stamp

This command lets you select a clip (or clips)
and redefine its SMPTE time stamp. The Origi-
nal Time Stamp and the User-Time Stamp are
then stored with your session.

When audio is first recorded, the User Time
Stamp will match the Original Time Stamp, but
you can change the User Time Stamp at any time
using the Time Stamp command. This feature is
particularly useful in post production situations
where the SMPTE timecode on video “work
prints” often changes from one edit revision to
another.

Replace Clip

This command opens a dialog that lets you re-
place multiple instances of an audio clip in a
playlist with another clip that you Command-
drag (Mac) or Control-drag (Windows) from the
Clip List.

The Replace Clip function only works on a selec-
tion that includes a single clip on one track. The
function is not available when the playlist selec-
tion includes the start points for two or more
clips. Also, if the selection is across several
tracks, only the selection in the first (top) track
is used.
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Compact

The Compact command deletes unused portions
of audio files to conserve disk space, and to pre-
pare for cleaner hard drive back-ups. The Com-
pact command also deletes audio if there are no
clips referencing the data.

A The Compact command is destructive and
cannot be undone. It permanently alters the
original audio files. There is no way to re-
cover data deleted with this command.

Because it permanently deletes audio data, the
Compact command should be used only after
you have completely finished your editing and
are sure that you have no further use for the un-
used audio data.

The Compact Selected command can pad the
clips of the compacted file by a user-selectable
amount. You may want to do this because

Pro Tools requires extra audio data before and
after audio clips to create crossfades. So, if your
clips have crossfades, or if you want to pad the
clips for the sake of any future trimming, you
should enter an appropriate amount of padding
(in milliseconds) to allow for this.

Export Clip Definitions

This command lets you export clip definitions
for audio files within each session, so that you
can use an audio file’s clips in another session,
or with another application that supports them.

The Export Clip Definitions command does not
export clips as audio files (unlike the Export
Clips as Files command). Instead, it stores
pointers to the clips within the parent source
file.



Export Clips as Files

This command lets you export clips as audio
files. Use this command if you intend to use a
clip in other sessions (or other audio applica-
tions) without using its parent source file.

This command also provides a way to convert
clips to a different audio format, sample rate, or
bit depth.

Export Clip Groups

This command lets you export clip groups as
files. Use this command if you intend to use a
clip group in other sessions.

If you are exporting clip groups to another hard
drive, you may want to copy any referenced au-
dio files as well. This way you can move clip
groups not only from one session to another, but
from one system to another.

Recalculate Waveform
Overviews

This command re-creates the session’s wave-
form overview data (the data used to create
waveform displays). Use this command if you
think overview data for a session has become
corrupted, or if you import audio files which
have no overview data into a session.

Recalculating waveform overviews may take
some time if there are many tracks in the ses-
sion.

Timeline Drop Order

This command sets whether tracks dragged from
the Clip List are dropped sequentially in a single
track or spread across multiple tracks.

Top to Bottom When enabled, clips are spread
across multiple destination (drop) tracks, or on
new tracks (when dragging to the area below the
last track or to the Track List).

Left to Right When enabled, clips are placed se-
quentially in a single destination (drop) track or
anewly created track (when dragging to the area
below the last track or to the Track List).
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Bounce options
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Convert After Bounce 8
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File Type 7
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Export Clip Definitions command 72

Export Clip Groups command 73

Export Clips as Files command 73

Find command 69

Recalculate Waveform Overviews command
73

Rename command 71

Replace Clip command 72

Select options 70

Select Parent in Project Browser command 69

Show options 70

Sort By options 71

Time Stamp command 72

Timeline Drop Order command 73

Clip menu 31

Bring to Front command 31
Capture command 32

Clip view options 23

Conform to Tempo command 34
Elastic Properties command 33
Group command 32

Identify Sync Point command 33
Lock command 31

Loop command 32
Mute/Unmute command 17
Quantize to Grid command 33
Rating 31

Regroup command 32

Remove Pitch Shift command 34
Remove Sync Point command 33
Remove Warp command 34
Rename command 32

Send to Back command 31
Ungroup All command 32
Ungroup command 32

Unlock command 31

Unloop command 32

Clip view options

Channel Name 23

Clip Gain Info 23

Clip Gain Line 23
Current Time 23
Display on All Channels 23
Name 23

No Time 23

Original Time Stamp 23
Overlap 23

Processing State 23
Rating 23

Scene and Take 23
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Sync Point 23
User Time Stamp 23
clips
locking 31
unlocking 31
Close Session command 3
Coalesce Trim Automation command 30

Coalesce VCA Master Automation command 30

Color Palette Window command 62
Compact command 72
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Window Configuration List 59
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Consolidate command 16
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Copy Selection To commands 17
Copy Special commands 14
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Copy To Send command 18
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Create Click Track command 30
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Current Feet+Frame Position command 54
Current Timecode Position command 54
Cut command 13
Cut Special commands 14

All Automation 14

Pan Automation 14

Plug-In Automation 14
Cut Time command 35

D
Delay Compensation option 50
Delete Fades command 20
Delete Tracks command 28
destructive editing

compacting audio files 72
Destructive Record mode 45
DigiDelivery 6
Disk Allocation dialog 52
Disk Space Window command 63



Display menu

Narrow Mix window option 21
DSP usage 63
Duplicate command 15
Duplicate Track command 28
Dynamic Transport Mode 47
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Universe view 22

Edit Window command 60
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Tempo Operations commands 36
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Export commands 10
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10
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E
Fade To End command 20
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Fades commands 20
Create 20
Delete 20
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File menu 3
Bounce to commands 6
Close Session command 3
Exit command 12
Export commands 10
Export MIDI command 10
Export Selected Tracks as New Session
command 10
Export Selected Tracks as OMF/AAF
command 10
Export Selected Tracks to Sequence
command 10
Export Session Info as Text command 10
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Get Info command 11

Import Audio command 9

Import Clip Groups command 9

Import MIDI command 9

Import Sequence from Avid Interplay
command 9

Import Session Data command 8

Import VENUE Channel Names as Track

Names command 10
Import Video command 9
New Session command 3
Open Recent command 3
Open Session command 3
Revert to Saved command 6
Save As command 3
Save As Template command 5
Save command 3
Save Copy In command 4
Score Setup command 11, 12
Send to Sibelius command 6
Send via DigiDelivery command 6
Find Clip List command 69
Flatten Performance command 40

G

Get Info command 11

Glide to All Enabled command 19
Glide to Current command 19
Group Clip command 32

Group Track command 27

H
Hardware Setup dialog 51
Heal Separation command 16
Help menu
Pro Tools documentation 67
Hide All Floating Windows command 59
Hide Others command 1
Hide Pro Tools command 1

|

I/O Setup dialog 53

Identify Beat command 42
Identify Sync Point command 33
Import Audio command 9

Import Clip Groups command 9
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Import commands 8
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Import Video command 9
Input Devices command 56
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Preserve Folder Hierarchy 5

K

Knowledge Base 67

L
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MIDI Real-Time Properties command 41



MIDI Setup commands

Input Devices 56

Input Filter 56

MIDI Beat Clock 55

MIDI Studio 55
MIDI Studio command 55
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MIDI Track Offsets command 41
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Mirror MIDI Editing option 48
Mix Window command 60
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N

Narrow Mix window option 21
New Session command 3

New Track command 27
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Preferences command 1
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Pro Tools documentation 67
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Hide Pro Tools command 1
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Quantize command 37
Quantize to Grid command 33
QuickPunch mode 45

Quit Pro Tools command 1

R
Rating clips 31
Recalculate Waveform Overviews command 73
Redo command 13
Regroup Clip command 32
Remove Duplicate Notes command 41
Remove Pitch Shift command 34
Remove Sync Point command 33
Remove Warp command 34
Rename Clip command 32
Rename Clip List command 71
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Replace Clip command 72
Restore Last Selection command 13
Restore Performance command 40
Revert to Saved command 6
rulers

Conductor rulers 22

Timebase rulers 22
Rulers view options 22, 23

S

Samples Time Scale 25
Satellite page 52
Save As command 3
Save as Template command 5
Save command 3
Save Copy In command 4
Items To Copy 4
Scale Tempo command 36
Score Setup 11
Scroll to Track command 29
Scrolling options 47
After Playback 47
Center Playhead 47
Continuous 47
None 47
Page 47
Scrub in Video Window command 46
S-Curve Tempo command 36
Select All command 15
Select Clip List options 70
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Select Parent in Project Browser command 69
Selection commands 15
Change Edit to Match Timeline 15
Change Timeline to Match Edit 15
Play Edit 15
Play Timeline 15
Send Clip to Back command 31
Send To Sibelius command 6
Send via DigiDelivery command 6
Sends A-E view options 25
Sends F-J view options 25
Separate Clip commands 16
At Selection 16
At Transients 16
On Grid 16
Services command 1
Session Setup window 54
Set Record Tracks to Auto Input command 29
Set Record Tracks to Input Only command 29
Setup menu 51
Click command 57
Current Feet+Frame Position command 54
Current Timecode Position command 54
Disk Allocation dialog 52
External Timecode Offsets command 55
Hardware Setup dialog 51
1/0O dialog 53
Machine Track Arming Profiles dialog 53
MIDI commands 55
Peripherals dialog 52
Playback Engine dialog 51
Preferences dialog 57
Session Setup window 54
Video Sync Offset command 53
Shift command 15
Show All command 1
Show Clip List options 70
SIP (Solo In Place) mode 49
Snap To commands 15
Next 15
Previous 15
Solo In Place mode 49
Solo Latch options
Latch 49
Momentary 49
X-OR (Cancels Previous Solo) 49
Solo Mode options
AFL (After Fader Listen) 49
PFL (Pre Fader Listen) 49
SIP (Solo In Place) 49



Solo modes and options 49

Sort By options 71

Split into Mono Track command 28
Step Input command 40

Stretch Tempo command 36

Strip Silence command 17
Synchronization page 52

System Usage Window command 63

T
Task Manager Window command 60
TCE Edit to Timeline Selection command 17
Tempo Operation commands
Constant command 36
Tempo Operations commands 36
Linear 36
Parabolic 36
Scale 36
S-Curve 36
Stretch 36
Tempo Operations Window 36
Tempo Operations Window command 36
Thin All Automation command 18
Thin Automation command 18
Time Compression/Expansion plug-in 17
Time Operations commands
Change Meter 35
Cut Time 35
Insert Time 35
Move Song Start 35
Time Operations Window 35
Time Operations Window command 35
Time Slot usage 63
Time Stamp Clip List command 72
Timebase rulers 22
Timecode Time Scale 25
Timeline Drop Order command 73
Track 27
Track List
show/hide 22
Track menu
Clear All Clip Indicators command 30
Clear Trim Automation 30
Coalesce Trim Automation 30
Coalesce VCA Master Automation 30
Create Click Track 30
Delete command 28
Duplicate command 28
Group command 27
Make Active command 28

Make Inactive command 28
New Track command 27
Scroll to Track command 29
Set Record Tracks to Auto Input command 29
Set Record Tracks to Input Only command 29
Split into Mono command 28
Write MIDI Real-Time Properties command 28
Track Number command 25
TrackPunch mode 45
Transport Online command 46
Transport view options 25
Transport Window command 61
Transpose command 38
Trim Clip commands 16
End to Fill Selection 16
Start to Fill Selection 16
Start to Insertion 16
To Fill Selection 16
To Selection 16
Trim to All Enabled Automation command 19
Trim to Current Automation command 19

U
Undo command 13
Undo History Window command 63
Ungroup All Clip command 32
Ungroup Clip command 32
Universe

show/hide 22
Universe window 22
Universe Window command 62
Unlock Clip command 31
Unloop Clip command 32
Use Squeezer option 8

\%

Video Out FireWire command 46

Video Sync Offset command 53

Video Track Online command 46

Video Window command 62

View menu 21
Automation view options 24
Edit Window view options 21
Main Counter view options 25
Mix Window view options 21
Rulers view options 22
Sends A-E view options 25
Sends F-J view options 25
Track Number command 25
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Transport view options 25
Waveform view options 24
Voices Allocated 63

W
Waveform view options
Outline views 24
Peak view 24
Power view 24
Rectified view 24
Window Configuration List 59
Window menu 59
Automation command 61
Big Counter command 61
Browsers commands 61
Color Palette command 62
Disk Space command 63
Edit command 60
Machine Track Arm command 62
Memory Locations command 62
Mix command 60
Project command 61
System Usage command 63
Task Manager command 60
Transport command 61
Undo History command 63
Universe command 62
Video command 62
Workspace command 60
Windows menu
Hide All Floating Windows command 59
Workspace browser 60
Workspace Window command 60
Write MIDI Real-Time Properties command 28
Write to All Enabled Automation command 19
Write to Current Automation command 19

X
X-OR (Cancels Previous Solo) Latch option 49
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